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About This Manual 

This manual focuses on the PCM360DW system and it will tell you how to install, configure and operate the 

system. Since it only contains the contents about how PCM360 software works with the DW devices like DTM 

and DM200, if your system contains other DAQ devices such as DAQ cards, or your system needs to get data 

via other technology such as OPC or other non-DW devices via Modbus, or your system is asked to transfer 

data to the third-party via Modbus or OPC protocol, you could consult the online Help of the system. And if your 

Purchase Order includes Web Server, SMS, or Text Output services, to get the configuration and operation 

information about these service modules, you could also consult the online Help. The contents above won’t be 

mentioned in this manual. 
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PCM360DW System Introduction 

ProvibTech’s Predictive Plant Condition Management system PCM360DW consists of PCM360 condition 

management software and Digital monitors. It is capable of digitally performing condition monitoring with 

waveform, spectrum and shaft XY vibration. The monitors include DTM and DM200. 

As a plant condition management system, PCM360DW could collect, store, and analyze machine health 

condition based on vibration, position and other process parameters and also it is capable of transmitting the 

information over LAN or internet. 

PCM360DW system focuses on dynamic and static data collection. Data will be processed digitally and 

transmitted to PCM360DW software via the same digital port that transmits Modbus protocol. This port can be 

defined as either RS485 or Ethernet one. PCM360DW will also collect and process standard Modbus 

information. 

Moreover, with PCM360DW system, all machine status can be easily and quickly integrated to one system, the 

configuration process is easier. It is a true integrated solution of monitoring process data, vibration data and 

other machine running status. 

 

Definition 
DW Device: A digital Modbus device of ProvibTech that is used for condition monitoring. PCM360DW system 

can receive DW data (dynamic waveform data) from these devices via Modbus RTU/TCP protocol. Currently, 

following meters of ProvibTech could be used as DW device: 

Device Name Firmware Version 

DTM10-201/301 27 or Later 

DTM20-101 28 or Later 

DM200 11 or Later 

Especially, to provide the phase reference input, the DTM10-201/301, DTM20-101 and DM200 should work 

with the DTM10-501 (firmware version 28 or later) or DTM10-502 (firmware version 28 or later). 

DAQ Server: The computer that installs DAQ&COM software and directly connects to hardware DAQ devices. 

Each PCM360DW system can have multi-DAQ Servers. 

DB Server: The computer that installs MS SQL Server 2008 (or MS SQL Server 2000) and PCM360 
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DBM&Server software. Each PCM360DW system only needs one DB Server. NOTE: To make PCM360DW 

work normally, user should keep the softdog in the USB port of DB Server. 

Display Terminal: The computer that installs Display software. Each PCM360DW system can have multiple 

Display Terminals. 

PCM360 DAQ&COM Software: Data acquisition and communication software, which is used to collect data in 

the field and receive data from digital meters based on Modbus protocol or through buffer output. 

PCM360 DBM&Server Software: Database Manager and Server software. DBM software is used to maintain 

the system database, and Server software is used to manage and configure the system services. 

PCM360 Display Software: Display and analysis software, which is used to display historical plots, real-time 

plots and lists. 

 

System Overview 
 Modbus Interface. Data could be transferred via Modbus RTU and Modbus TCP protocols. The third-party 

monitors complied with the two protocols can easily be integrated to the system. 

 Transfer data based on OPC technology. 

 Dynamic data and static data collection. And the data could be displayed by collected time order. 

 Maximum 2000 static samples are available. 

 Plots and analysis: waveform plot, spectrum plot, full spectrum plot, shaft XY vibration plot, trend plot, 

alarm list, status list, bar graph, waterfall plot, etc. 

 Save plots as .bmp format. 

 Up to 800 lines of spectrum resolution with DTM and DM200. The available channel’s sampling 

frequencies are 500Hz, 4 KHz, and 25 KHz. 

 1X, 2X, NOT1X amplitude and phase are available. 

 Status of machine train and dynamic data definition. 

 DTM provides one vibration channel and one phase reference channel. DM200 provides two vibration 

channels and one phase reference channel. 

 Both of DTM and DM200 are capable of storing the trend data and alarm data automatically, and can 

upload the waveform and spectrum generated by the alarm data to the condition monitoring system. 

 Data from DTM and DM200 channels under the same machine train will be collected synchronously. 
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 DTM and DM200 work in parallel to improve the data update rate. For system that contains multiple DTM 

and DM200 digital meters, multiple serial ports or TCP connections could be used. 

 User-friendly interface for instant data analysis with minimal training required of field staff. 

 Maximum flexibility and expandability of the software system with object oriented modular design. 

 Build on Microsoft® SQL Server database to assure better data management and more reliable network. 

 Client/Server architecture let Display terminal has access to database to display historical data. 

 Browser/Server architecture enables user to access PCM360DW system via browser. 

 Multiple hardware output modules are ready for further data transfer and annunciation in relays and 

current transmission. 

 24 hours notification through onsite alarms, operator interface and even SMS messaging on GPRS 

mobile. 

 Maximize productivity by minimizing machine down time. 

 Machine management with automatic traffic light status indication and process data collection into a 

centralized database. 

 Ideal for working with turbines, pumps, blowers, motors, and compressors. Can be used in refinery, 

petroleum, steel, fossil power, hydro power, cement, transportation, etc. 

 Assist plant managers to take intelligent maintenance decision based on acquired data. 

 

Plots Supported by Different Measurement Points 
 Plots supported by single-channel measurement point mapped with DTM or DM200 

 Waveform 

 Spectrum 

 Dynamic waterfall 

 Static and dynamic trend 

 Bar graph 

 Alarm list 

 Status list 

 Plots supported by dual-channel measurement point mapped with DM200 

 Waveform 
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 Spectrum 

 Full spectrum 

 Shaft XY vibration 

 Dynamic waterfall 

 Static and dynamic trend 

 Bar graph 

 Alarm list 

 Status list 

 

System Requirements 
 Recommended Operating System: Windows XP SP2 or later version 

 Processor: P4 3.0GHz or faster 

 Memory: RAM: 512MB or more 

 Hard Disk: 40GB or more 

 Drive: A DVD Drive 

 Display: 1280*1024 high color, 32-bit (Recommended) 

 System Time Format Setting: You are strongly recommended to set System Time Format as [HH: mm: 

ss]. Please follow the steps to check or change the system time format. 

1. Open Control Panel; 

2. Double click Regional Options tab; 

         

3. Click Customize button on Regional Options tab; 
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4. On Time tab, select Time format as [HH: mm: ss]. 
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PCM360DW System Installation 

System Layout Diagram 
Fig1 indicates a system layout diagram, on which data is transmitted via Modbus RTU protocol. 

 

Fig1. 

 

Fig2 indicates a system layout diagram, on which data is transmitted via Modbus TCP protocol. 
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Fig2. 

NOTE: A single computer can be used as a DB Server, a DAQ Server, and also a Display Terminal, i.e. for a 

small setup, with relatively few monitoring points, single COMPUTER can act as the DB Server, DAQ Server 

and Display unit. This is a common configuration when a COMPUTER is dedicated for diagnosis and analysis 

on rotating machines. In addition, if you purchase Web Server, you could access the system via browsers. 

 

System Field Wiring Diagram 
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DTM10-201/501 Field-Wiring Diagram 

OK

ALT

DNG

BYP

TRX

PROVIBTECH

BUF

+

 

NOTES: 

 Power supply 2 and 4-20mA (2) are optional. 

 Alert and Danger relays are connected as normally open. Connect ARM with NC to form a normally closed 

configuration. 

 Closing COM and RST/BYP with an external continuous or momentary switch will initiate a remote reset. Temporarily 

closing the switch will result in a system reset, continuous close will result in a system bypass. 

 For DTM10-201, to provide phase reference, Trip/Multi and COM ends are used for phase reference input. Moreover, 

the DTM10-201 won’t provide Multiply Alarm function anymore, so you should set Multiply Alarm property to “None” 

by DTM-CFG software. 

 DTM10-501 could output phase reference signal; Trip/Multi and COM ends of DTM10-501 are used for phase 

reference output. 
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 Mostly, DTM10-201 works with DTM10-501 to provide phase reference output. So connect Trip/Multi of DTM10-201 

with Trip/Multi of DTM10-501 and connect COM of DTM10-201 with COM of DTM10-501. 

 

DTM10-201/501 Hazardous Area Field-Wiring Diagram 

OK

ALT

DNG

BYP

TRX

PROVIBTECH

BUF

+

 

NOTES: 

 Power supply 2 and 4-20mA (2) are optional. 

 Alert and Danger relays are connected as normally open. Connect ARM with NC to form a normally closed 

configuration. 

 Closing COM and RST/BYP with an external continuous or momentary switch will initiate a remote reset. Temporarily 

closing the switch will result in a system reset, continuous close will result in a system bypass. 

 For DTM10-201, to provide phase reference, Trip/Multi and COM ends are used for phase reference input. Moreover, 

the DTM10-201 won’t provide Multiply Alarm function anymore, so you should set Multiply Alarm property to “None” 
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by DTM-CFG software. 

 DTM10-501 could output phase reference signal; Trip/Multi and COM ends of DTM10-501 are used for phase 

reference output. 

 Mostly, DTM10-201 works with DTM10-501 to provide phase reference output. So connect Trip/Multi of DTM10-201 

with Trip/Multi of DTM10-501 and connect COM of DTM10-201 with COM of DTM10-501. 

 

DTM10-301/502 Field-Wiring Diagram 

OK

ALT

DNG

BYP

TRX

PROVIBTECH

BUF

PROBE

+

 

NOTES: 

 Power supply 2 and 4-20mA (2) are optional. 

 Alert and Danger relays are connected as normally open. Connect ARM with NC to form a normally closed 

configuration. 

 Closing COM and RST/BYP with an external continuous or momentary switch will initiate a remote reset. Temporarily 
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closing the switch will result in a system reset, continuous close will result in a system bypass. 

 For DTM10-301, to provide phase reference, Trip/Multi and COM ends are used for phase reference input. Moreover, 

the DTM10-301 won’t provide Multiply Alarm function anymore, so you should set Multiply Alarm property to “None” 

by DTM-CFG software. 

 DTM10-502 could output phase reference signal and Trip/Multi and COM ends of DTM10-502 are used for phase 

reference output. 

 Mostly, DTM10-301 works with DTM10-502 to provide phase reference output. So connect Trip/Multi of DTM10-301 

with Trip/Multi of DTM10-502 and connect COM of DTM10-301 with COM of DTM10-502. 

 

DTM20 Field-Wiring Diagram 

To
Alert

To
Danger

Trip /Multiply
or phase 
reference 

input

Remote
Reset

TM0200 or 
PLC� DCS

Buffer
Out

PLC/DCS or  
DTM-CFG

Power
Supply 1
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485+RS-
485-

BUF
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ALT

DNG

BYP

TRX

PROVIBTECH

BUF

+

Power
Supply 2

TM0200 or 
PLC� DCS

RED

WHITE

SHIELD

0782A
0793V

AB

 

NOTES: 

 Power supply 2 and 4-20mA (2) are optional. 
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 Alert and Danger relays are connected as normally open. Connect ARM with NC to form a normally closed 

configuration. 

 Closing COM and RST/BYP with an external continuous or momentary switch will initiate a remote reset. Temporarily 

closing the switch will result in a system reset, continuous close will result in a system bypass. 

 To provide phase reference, Trip/Multi and COM ends are used for phase reference input. Moreover, the DTM20 

won’t provide Multiply Alarm function anymore, so you should set Multiply Alarm property to “None” by DTM-CFG 

software. 

 Mostly, DTM20 works with DTM10-501/502 to provide phase reference output. So connect Trip/Multi of DTM20 with 

Trip/Multi of DTM10-501/502 and connect COM of DTM20 with COM of DTM10-501/502. 

 

DTM20 Hazardous Area Field-Wiring Diagram 

OK
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BUF
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NOTES: 
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 Power supply 2 and 4-20mA (2) are optional. 

 Alert and Danger relays are connected as normally open. Connect ARM with NC to form a normally closed 

configuration. 

 Closing COM and RST/BYP with an external continuous or momentary switch will initiate a remote reset. Temporarily 

closing the switch will result in a system reset, continuous close will result in a system bypass. 

 To provide phase reference, Trip/Multi and COM ends are used for phase reference input. Moreover, the DTM20 

won’t provide Multiply Alarm function anymore, so you should set Multiply Alarm property to “None” by DTM-CFG 

software. 

 Mostly, DTM20 works with DTM10-501/502 to provide phase reference output. So connect Trip/Multi of DTM20 with 

Trip/Multi of DTM10-501/502 and connect COM of DTM20 with COM of DTM10-501/502. 

 

DM200 Field-Wiring Diagram 

 
NOTES: 

 Alert and Danger relays are connected as normally open. Connect A-A with A-AC to form a normally closed 

configuration. 
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 Closing COM and RST/BYP with an external continuous or momentary switch will initiate a remote reset. Temporarily 

closing the switch will result in a system reset, continuous close will result in a system bypass. 

 To provide phase reference, Trip/Multi and COM ends are used for phase reference input. Moreover, the DM200 

won’t provide Multiply Alarm function anymore, so you should set Multiply Alarm property to “None” by DM200-CFG 

software. 

 Mostly, DM200 works with DTM10-501/502 to provide phase reference output. So connect Trip/Multi of DM200 with 

Trip/Multi of DTM10-501/502 and connect COM of DM200 with COM of DTM10-501/502. 

 

DM200 Hazardous Area Field-Wiring Diagram 

 

NOTES: 

 Alert and Danger relays are connected as normally open. Connect A-A with A-AC to form a normally closed 

configuration. 

 Closing COM and RST/BYP with an external continuous or momentary switch will initiate a remote reset. Temporarily 

closing the switch will result in a system reset, continuous close will result in a system bypass. 

 To provide phase reference, Trip/Multi and COM ends are used for phase reference input. Moreover, the DM200 
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won’t provide Multiply Alarm function anymore, so you should set Multiply Alarm property to “None” by DM200-CFG 

software. 

 Mostly, DM200 works with DTM10-501/502 to provide phase reference output. So connect Trip/Multi of DM200 with 

Trip/Multi of DTM10-501/502 and connect COM of DM200 with COM of DTM10-501/502. 

 

DTM96 Field-Wiring Diagram 

Each DTM96 enables up to 32 DTM modules to be networked together via Modbus protocols. 
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NOTE: 

 Power supply 2 is optional. 
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System Software Installation 

SQL Server 2008 Setup 

MS SQL Server 2008 is used for database management of PCM360DW system. It must be installed on the DB 

Server. Following contents show how to install and configure MS SQL Server 2008 Workgroup (32-bit) Edition. 

If the system uses the MS SQL Server 2000 Personal Edition for database management, please consult 

Appendix I. Installing SQL Server 2000. 

 

CAUTION: Before install MS SQL Server 2008, make sure that you log on the computer by account 

that belongs to Windows Administrators group and the account password can’t be blank. After MS 

SQL Server 2008 was installed, user could log on the computer by other Windows accounts, but user 

is forbidden to change or disable the Windows account for SQL Server Services. Any changes on the 

account may cause the SQL Server Services to stop. 

 

Update Microsoft Windows Installer 

Microsoft Windows Installer (MSI) is an application installation and configuration service for Windows that 

centrally manages application installation, configuration, and application uninstall. MS SQL Server 2008 Setup 

requires Microsoft Windows Installer 4.5 or a later version (It can be downloaded from Microsoft Download 

Center). 

ProvibTech provides MSI 4.5 setup package on DBM&Server Installation CD. It is located in the directory of 

“MS Update Pack/ Microsoft Windows Installer V4.5”. Please select the proper setup edition according to 

your operating system version and platform. 

 For Windows Vista: 

x86 Platform: Windows6.0-KB942288-v2-x86.msu 

 For Windows Vista Service Pack 1: 

x64 Platform: Windows6.0-KB942288-v2-x64.msu 

 For Windows Server 2008: 

IA64 Platform: Windows6.0-KB942288-v2-ia64.msu 

 For Windows Server 2003 Service Pack 1: 

x86 Platform: WindowsServer2003-KB942288-v4-x86.exe 
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 For Windows Server 2003 Service Pack 2: 

x64 Platform: WindowsServer2003-KB942288-v4-x64.exe 

 For Windows XP 64-bit Editions: 

IA64 Platform: WindowsServer2003-KB942288-v4-ia64.exe 

 For Windows XP Service Pack 2 and Windows XP Service Pack 3 (32-bit platforms): 

x86 Platform: WindowsXP-KB942288-v3-x86.exe 

For complete information on installing or upgrading Windows installer, please see the Microsoft Website. 

 

In this chapter, we take Windows XP Service Pack 2 (32-bit) operating system as an example, and will guide 

you through steps to install MSI 4.5. 

1. Insert DBM&Server CD into the DVD-ROM, and select MS Update Pack, Microsoft Windows Installer 

V4.5, Windows XP x86 from the root folder of the DVD-ROM. And then double click 

WindowsXP-KB942288-v3-x86.exe. You will see the “Extracting Files” window. 

 

A few seconds later, you will see the following dialog box. Click Next button to proceed with the installation. 

 

2. “License Agreement” dialog box is launched. Select “I Agree” radio button and then click Next button. 
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3. The Setup will scan the services that are running. Click Continue button. 

 

4. The Setup is inspecting the current configuration and updating the files. 

 

The installation finished. See picture below. 

 

Since MSI version 4.5 won’t take effect until the computer is restarted, you should leave “Do not 

restart now” unchecked and then click Finish button. 

Additional patches for SQL Sever Express 

Additional patches as follows: 
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Windows Power Shell：KB926140. 

Windows Remote Management：KB936059. 

Select the corresponding operating system patches and install all the patches in a similar way as Microsoft 

Windows Installer. 

Installing SQL Server 2008 

If the DB Server uses Windows XP SP2 operating system, we recommend that you purchase the MS SQL 

Server 2008 Workgroup (32-bit) Edition. 

1. Insert the SQL Server 2008 Work Group Installation Media into the DVD-ROM. From the root folder, 

double-click Setup.exe. SQL Server Setup will scan the system environment first (In some Windows 

operating system, the result might not be displayed normally, but it doesn’t affect the installation process). 

The version information about SQL Server 2008 work group and .NET Framework is checked by SQL 

Server Setup. 

 If SQL Server 2008 find the .NET Framework version 2.0, you will see the window like below: 

 

The SQL Server Setup will launch the waiting window. You may wait a few minutes. Never do any 

operation during the waiting time. After that, you will go to step “2”. 

 If the SQL Server Setup can’t find Framework version 2.0, you will see the window like below: 

 

Then SQL Server Setup will launch the following dialog box. Click OK button to install .NET Framework. 

 

The SQL Server Setup will launch “Welcome to Setup” window. On the window, select radio button of “I 

have read and ACCEPT the terms of the License Agreement”. And then click Install button. 
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The SQL Server Setup will launch “Download and Install Progress” window. And it will automatically 

connect to the internet to download the most recent version of .NET Framework. If the connection failed, 

the Setup will try another 4 times. And if it still failed, the Setup will install the .NET Framework from the 

local computer. 

 
The .NET Framework is installed successfully. Click Exit button. 

 
2. The SQL Server Setup will launch ”SQL Server Installation Center” window. 
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Select “Installation” on the installation guide left side, and select “New SQL Server stand-alone installation or 

add features to an existing installation” from the right side. 

           

3. The SQL Server Setup will launch “Setup Support Rules” window. 

 
Click Show details >> button to view the details. If “Failed” items existed, OK button will be inactivated. You 

must correct them before the installation can be continued. 

4. The SQL Server Setup will launch “Product Key” window. Select “Enter the product key” radio button, and 

then enter the 25-character product key. You could get the product key on the installation CD. 
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If installing a free edition of SQL Server, you should select “Specify a free edition” and then select “Enterprise 

Evaluation” from the list. Note that the trial period for the free edition is 180-day! 

After that the SQL Server Setup will launch “License Terms” window. Select “I accept the license terms” check 

box and click Next button. 

 
The SQL Server Setup will launch “Setup Support Files” window below. Click Install button. 

 
5. The SQL Server Setup will launch “Setup Support Rules” window. 
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If “Failed” items existed, OK button will be deactivated. You must correct them before the installation can be 

continued. 

6. The SQL Server Setup will launch “Feature Selection” window. 

        
Click Select All button and use the default feature directory. And then click Next button. 

7. The SQL Server Setup will launch “Instance Configuration” window. Select “Default instance” radio 

button, and use the default Instance ID and root directory. And then click Next button. 

 
The SQL Server Setup will check the disk space and show the result on the “Disk Space Requirements” 

window. Click Next button. 
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8. The SQL Server Setup will launch “Server Configuration” window. Click “Use the same account for all SQL 

Server services” button. 

 
On the following window, type the name and password of the current Windows account. Later click OK button. 

Note that the account must belong to the Windows Administrators group and the password must not be blank. 

 
For example, the current Windows account is “Administrator”. 

 
Picture below shows the window after the account information was set. Later click Next button to continue the 

installation. 
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9. The SQL Server Setup will launch “Database Engine Configuration” window. 

 
Select “Account Provisioning” tab and select “Mixed Mode (SQL Server authentication and Windows 

authentication)” radio button. Then type the logon password of the current Windows account. Later click Add 

Current User button. 

 
10. The SQL Server Setup will launch “Analysis Services Configuration” window. 
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Select “Account Provisioning” tab and click Add Current User button. Then click Next button. 

 
11. The SQL Server Setup will launch “Reporting Services Configuration” window. 

 
Select “Install the native mode default configuration” radio button and click Next button. 
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Then you will see “Error and Usage Reporting” window. Click Next button. 

12. The SQL Server Setup will launch “Installation Rules” window. 

 
If “Failed” items existed, OK button will be deactivated. You must correct them before the installation can be 

continued. 

13. The SQL Server Setup will launch “Ready to Install” window. 

 
Click Install button to start the installation progress. 
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Click Next button. 

 
Then SQL Server Setup will launch “Complete” window. Click Close button to exit. 

 
Please restart your computer after the MS SQL Server 2008 was installed. 

 

Configure MS SQL Server 2008 

After installed SQL Server, you should configure the MS SQL Server. 

Activate the ‘sa’ Account 

Select Windows Start->All Programs->Microsoft SQL Server 2008->SQL Server Management Studio. 

Then “Connect to Server” window is launched. Set Server type option as “Database Engine”. 
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If the Server name option is blank, you should select “Browse for more…” from the list. 

 

Then following window is launched. 

 

Select “Local Servers” and open “Database Engine” node, and then select the server name, for 

example: ”DSH”. 

 

Later click OK button to return to “Connect to Server” window. 
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Set Authentication option as ‘Windows Authentication’. Later click Connect button. 

 
Select the menu item named ‘Properties’ as it is shown in the Figure above. Click it and the follow window will 

pop up: 
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Select the tree node name ‘Security’ on the left and check the button named ‘SQL Server and 

Windows Authentication’. 
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Select the tree node name ‘Connections’ on the left and check the button named “Allow remote 

connections to this server”. 
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Click the button ‘OK’ and exit the window.。 

Manage to find the account named ‘sa’ as follows. 
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Right click on the node named ‘sa’ to open the ‘Properties’ window. 

Click on the node named ‘General’ and check the button ‘Map to Credentials’. 
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Click on the node named ‘Status’ on the left and set all the status of the popup window as follow. 
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SQL Server Login Setting 

Select Windows Start->All Programs->Microsoft SQL Server 2008->SQL Server Management Studio. 

Then “Connect to Server” window is launched. Set Server type option as “Database Engine”. 

 

If the Server name option is blank, you should select “Browse for more…” from the list. 
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Then following window is launched. 

 

Select “Local Servers” and open “Database Engine” node, and then select the server name, for 

example: ”DSH”. 

 

Later click OK button to return to “Connect to Server” window. 

 

Set Authentication option as “SQL Server Authentication”. Type “sa” in Login edit box and type logon password 
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of Windows Administrator account in Password edit box. Later click Connect button. 

 

If succeeded in connecting to the server, the “Microsoft SQL Server Management Studio” window will be 

launched. 

 

From the tree view above, select DSH (the server name you selected), Security, Logins and double click sa. 

 

Click “Enforce password policy” to make it un-checked. And empty “Password” and “Confirm Password” to 

leave the “sa” password blank. Later click OK button. 

 

Click Yes button in window below. 
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Note that the login password of “sa” should be set as blank; otherwise PCM360 system can’t connect to SQL 

Server. 

 

Network Protocols Setting 

If the database is SQL Sever Express, the key word ‘SQL Server (SQLEXPRESS) should take the place of the 

key word   ‘SQL Server (MSSQLSERVER)’. 

 

Select Windows Start->All Programs->Microsoft SQL Server 2008->Configuration Tools->SQL Server 

Configuration Manager. The “Sql Server Configuration Manager” window is launched. 

 

Select SQL Server Configuration Manager->SQL Server Services from the tree view. Then stop SQL 

Server (MSSQLSERVER) service. 

Select SQL Server Network Configuration from the left side tree view, and then select Protocols for 

MSSQLSERVER beneath this node. 

 

Right click “TCP/IP” and select “Enable” from shortcut menu. If the status of “TCP/IP” already shows “Enable”, 

you needn’t do the operation. 
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Click OK button.  

If the database is SQL Server Express, the TCP port must be assigned manually .Double click the left button of 

the mouse on the item named ’TCP/IP’, the TCP/IP propriety window will popup. Click the label named ‘IP 

Address’ on the top. Clear the contents of all the items with the name of ‘TCP Dynamic Ports’ and set the 

contents of all the items with the name of ‘TCP Port as ‘1433’. 

 

Re-select SQL Server Configuration Manager->SQL Serve Services from the tree view, and select SQL 

Server (MSSQLSERVER). Right click SQL Server (MSSQLSERVER) and select Start from shortcut menu to 

start SQL Server service. 
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NOTE: To apply all configurations, you must restart the computer. 

 

Start Mode Setting 

If the database is SQL Sever Express, the agent function is disabled. Instead, start the service named ‘SQL 

Server Browser’ in a similar way as follows. 

 

Set the start mode of “SQL Server Agent” to “Automatic”. On “Sql Server Configuration Manager” window, 

select SQL Server Services. Currently, the SQL Server Agent’s start mode is set as “Manual”. 

 

Double click SQL Server Agent and the window below is launched. Select Service tab. 

        

Set the “Start Mode” to “Automatic” and then click OK button. 
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Now you have finished all the settings on MS SQL Server 2008. 

NOTE: To apply all configurations, you must restart the computer. 

 

Modbus RTU-TCP Converter 

Modbus RTU-TCP Converter Field-Wiring Diagram 

The converter is a 1-port advanced Modbus gateways that converts between Modbus TCP and Modbus 

ASCII/RTU protocols. It can be used to allow Ethernet master to control serial slaves, or to allow master to 

control Ethernet slaves. Up to 31 serial slaves can be connected simultaneously. 
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NOTE: 

 Power supply 2 is optional. 

 

Installing MGate Manager Software 

Put the MGate Manager Installation Media into the DVD-ROM. Find “MGate Manager” folder and double click 

MGM_Setup_Ver1.2_Build_07081514.exe. Then follow the tips on the windows to install the software. 

 

Configuring MGate Manager Software 

To run MGate Manager Software, select Windows Start->All Programs->MGate Manager->MGate 
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Manager. The software main window is launched. 

 

Before running the MGate Manager software, make sure the computer and Modbus RTU-TCP Converter 

are connected to the same network. For configuration purpose, the converter unit must be connected the 

available power source (Please refer to Modbus RTU-TCP Converter Field-Wiring Diagram). 

 

MGate Manager software should be connected to the unit before it can be configured. Click Broadcast Search 

button to find every converter on the LAN. When the search is complete, every converter that is found on the 

LAN will appear in the window with MAC Address and IP Address. Picture below indicates the condition that a 

converter was found. 

 

Select the converter unit and then Configuration button is activated. Click this button to open “Configuration” 

window. See picture below. 
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 Mode Tab 

On Mode tab, select “RTU Slave Mode” option. 

 
 

 Network Tab 

 
Parameters are set as follows: 
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 Name: You can enter a name to help you identify this unit. 

 Network Configure: Select “Static” in this field. 

 IP Address: Set a unique IP Address on the LAN. The default is “192.168.127.254”. 

 Netmask: Set the same netmask address with the computer the unit currently connected to. 

 Gateway: Set the same Gateway address with the computer the unit currently connected to. 

 DNS1: Set the same DNS1 address with the computer the unit currently connected to. 

 DNS2: Set the same DNS2 address with the computer the unit currently connected to. 

 Password: Leave this field blank. 

 Confirm Password: Leave this field blank. 

 

 Serial Tab 

 

Parameters are set as follows: 

 Baudrate, Parity, Stop bit: The three communication parameters should match the communication 

parameters of DW devices that are connected to this unit. 

 Flow Control: Select “None” in this field. 

 FIFO: Select “Enable” in this field. 

 Interface: Select “RS485 2W” or “RS485 4W” in this field. 

 

 Slave ID Map Tab 

Use the default parameters setting on this tab. 

 

 Modbus Tab 



PCM360DW Condition Management System 
 
 
 

ProvibTech      Phone: +1-713-830-7601 Fax: +1-281-754-4972 sales@provibtech.com, www.provibtech.com 
48 

Use the default parameters setting on this tab. 

 

 Priority Control Tab 

Use the default parameters setting on this tab. 

 

After parameters on tabs above are configured, click OK button on “Configuration” window and following 

window is launched. 

 
If parameters are successfully downloaded to converter unit, software will return to the main window. 

 

Installing USB-RS485 or USB-RS232 Converter Driver 

1. Connect USB-RS232 or USB-RS485 Converter to a spare USB port on your computer. Put the Modbus 

installation media into DVD-ROM. The computer will launch the window below. Select “No, not this time” 

and click Next button. 

 

2. Select “Install the software automatically (Recommended)” and then click Next button. 
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3. The computer now is beginning to scan the installation file and then install the USB-RS converter driver. 

 

Picture below shows the condition that the USB-RS converter driver hasn’t been installed. To view the 

information, right click My Computer and select Manage command. On “Computer Management” window, 

navigate Device Manager and then select “Other devices/USB Serial Port”. 

 

4. The installation of USB-RS converter driver was finished. Click Finish button. 
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After the USB-RS converter driver was installed, the computer begins to install COM port. The installation 

process is the same as the installation of USB-RS converter driver, so we don’t mention it here. After the two 

were installed, a new USB Serial Port “COM3” is added below “Ports (COM&LPT)” and “USB Serial Converter” 

is added below “Universal Serial Bus controllers”. See picture below: 

 

NOTE: After installed the USB-RS converter driver, you could use the Auto Search function of DTM-CFG or 

DM200-CFG software to find the system COM port and other communication parameters. 

 

Installing DTM-CFG Software 

Put the DTM-CFG Installation Media into DVD-ROM. From the root folder, double click Setup.exe and then 

follow the tips on dialog windows to install the software. If “Locked File Detected” window is launched, you can 

mark “Don’t display this message again” and click Ignore button to continue the installation. 

 

Installing DM200-CFG Software 

Put the DM200-CFG Installation Media into DVD-ROM. From the root folder, double click Setup.exe and then 
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follow the tips on dialog windows to install the software. If “Locked File Detected” window is launched, you can 

mark “Don’t display this message again” and click Ignore button to continue the installation. 

 

Installing PCM360 DAQ&COM Software 

Put the DAQ&COM Installation Media into DVD-ROM. From the root folder, double click Setup.exe and then 

follow the tips on dialog windows to install the software. If “Locked File Detected” window is launched, you can 

mark “Don’t display this message again” and click Ignore button to continue the installation. 

 

 

Installing PCM360 Display Software 

CAUTION: The contents below only apply to Display Terminals that are not used as DB Server. 

 If your Display Terminal runs on Windows 2000 operating system, Microsoft Data Access Components 

(MDAC.exe) 2.9.1 (or later version) should be installed. 

 If your Display Terminal runs on Windows Vista operating system, please download the most recent 

version of Service Package from Microsoft Website to upgrade the operating system. For convenience, 

we supply SP1 for Windows Vista x86 Platforms and it is located in the folder “Windows vista x86 SP1” at 

the directory of “DBM&Server Installation/MS Update Pack”. 

 If your Display Terminal runs on Windows XP SP2 (or later version) operating system, there is no need to 

install MDAC 2.9.1 (or later version). 

 

Put the Display Installation Media into DVD-ROM. From the root folder, double click Setup.exe and then follow 

the tips on dialog windows to install the software. If “Locked File Detected” window is launched, you can mark 

“Don’t display this message again” and click Ignore button to continue the installation. 
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Installing PCM360 DBM&Server Software 

CAUTION: The “File system” property of the disk in which the DBM&Server software’s 

destination folder located must be “NTFS” format! 

 
 

Put the DBM&Server Installation Media into DVD-ROM. From the root folder, double click Setup.exe and then 

follow the tips on dialog windows to install the software. If “Locked File Detected” window is launched, you can 

mark “Don’t display this message again” and click Ignore button to continue the installation. 

 

 

Installing PCM360 Modbus RTU 

CAUTION: Modbus RTU should be installed on DAQ Server. Before installing it, ensure the DAQ&COM 

software has been installed on the DAQ Server. 

Put the Modbus Installation Media into DVD-ROM. From the root folder, open “Modbus RTU-Setup” folder. 

Double click Setup.exe and then follow the tips on dialog windows to install the software. 
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Installing PCM360 Modbus TCP Client 

CAUTION: Modbus TCP Client should be installed on DAQ Server. Before installing it, ensure the DAQ&COM 

software has been installed on the DAQ Server. 

Put the Modbus Installation Media into DVD-ROM. From the root folder, open “Modbus TCP Client-Setup” 

folder. Double click Setup.exe and then follow the tips on dialog windows to install the software. 

 

Attach PCM360DW Database to SQL Server 

CAUTION: Before you run the DBM software, ensure both “SQL Server” and “SQL Server Agent” services are 

started. 

Select Windows Start->All Programs->PCM360 Plant Condition Management System->PCM360 DBM 

command to run the software. 

When you first run DBM software, “Database Manager” window will be launched. 

 
Click Attach DB button to attach the PCM360 database to SQL Server, if the software succeed in attaching 

database, it will launch a message box below: 

 
NOTES: 

1. Before attach PCM360 database, you cannot operate the database by the software. 

2. After attach the database, you should license the PCM360DW system, or else you cannot operate the 

database except detaching it. 
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Installing License Software 

CAUTION: To license PCM360DW system, please install PCM360DW License software on DB Server. Before 

install License software, make sure MS SQL Server and DBM&Server software are installed, and moreover 

the PCM360DW database is attached to SQL Server. 

PCM360DW License installation process is below: 

1. Put the License Installation Media into DVD-ROM and double click Setup.exe to launch the “Check the 

Serial Number of PCM360 System” window. 

2. Enter 20-character serial number. The serial number can be found on the PCM360 License Installation 

CD. And then click Next button. 

 

3. If the license succeeds, a message box will appear. Click OK button. 



PCM360DW Condition Management System 
 
 
 

ProvibTech      Phone: +1-713-830-7601 Fax: +1-281-754-4972 sales@provibtech.com, www.provibtech.com 
55 

System Software Un-installation 

Uninstalling DTM-CFG Software 

Select Windows Start->All Programs->DTM->Uninstall. And later click OK button on following “Confirm File 

Deletion” window. 

 

 

Uninstalling DM200-CFG Software 

Select Windows Start->All Programs->DM200->DM200-CFG Uninstall. And later click OK button on 

following “Confirm File Deletion” window. 

 

 

Uninstalling PCM360 DAQ&COM Software 

Exit PCM360 DAQ&COM software first. Select Windows Start->All Programs->PCM360 Plant Condition 

Management System->Uninstall->Uninstall DAQ&COM. 

CAUTION: If uninstall DAQ&COM software, all devices (contain DAQ cards, Modbus RTU, Modbus TCP 

Client, OPC Client) on local DAQ Server will be removed. 

 

Uninstalling PCM360 Display Software 

Exit PCM360 Display software first. Select Windows Start->All Programs->PCM360 Plant Condition 

Management System->Uninstall->Uninstall Display. 

 

Uninstalling PCM360 DBM&Server Software 

Before uninstall DBM&Server, please execute the following first: 
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1. Exit PCM360 software (DAQ&COM, Display, Server, and Web Server) on the DB Server. 

2. Detach PCM360DW database from SQL Server: Run PCM360 DBM software and click Detach DB 

button on main window. See picture below: 

 
Then exit PCM360 DBM software. Select Windows Start->All Programs->PCM360 Plant Condition 

Management System->Uninstall->Uninstall DBM&Server. 

CAUTION: If uninstall DBM&Server software, all PCM360 services (contain Modbus TCP Server, OPC Server, 

SMS, Text Output) will be removed. 
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PCM360DW System Configuration 

This part focuses on the configuration of the system. It contains device configuration with the related 

configuration software and PCM360DW system configuration with PCM360 software. In this manual, we only 

introduce the features with the system, and don’t show detailed information about how to configure the DW 

device DTM and DM200. You can consult DTM-CFG User Manual, DM200-CFG User Manual and the related 

Hardware User Manual for details. 

PCM360 DAQ&COM software is used to configure the system information. We don’t introduce all the features 

and functions of this software. So for detailed information about this software, please see the online Help. 

 

DTM Configuration with DTM-CFG Software 
CAUTION: To set the device ID, ensure the computer connects one DTM device only. If multi-devices are 

connected, please disconnect the connection between the computer and other devices. And note that the 

computer could connect multi-devices when it is not in process of device ID setting. 

When configuring the DTM device, we recommend that the computer connects one DTM device only! Run 

DTM-CFG software, and then select Advanced command from Operation menu. Click Yes button on 

“CAUTION” window. 

 

Select Module ID Setup command from Module-Configuration menu. Then type 63 (factory default setting) 

in field of DTM ID and click OK button to exit the window. See picture below: 

 
Then select Communication Setup command from Communication menu to launch the “Communication 
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Setup” window. Click Auto Search button on this window to launch the “Communication” window. On 

“Communication” window, you could select “Auto” from left pane to let computer automatically scan the 

available COM port, and then select “Manual” from right pane to set communication parameters manually. We 

strongly recommend that user sets the baud rate of DTM device as 38400bps or 115200bps. Finally click 

Auto Search button to test the communication between the software and DTM device. Once the 

communication is successful, the software will launch a message window to inform you. 

After successfully connect the software and DTM device, you can re-set the configuration parameters and then 

download it to DTM device. Since all DTM devices were specified the same DTM ID (default is 63) when they 

left the factory, you must re-specify the slave address of each DTM device so that the system can work 

normally. Re-select Module ID Setup command from Module-Configuration menu, and then type a number 

which must be integer between 0 and 255 in the DTM ID field and all devices in the same system must be 

given a unique device ID. Later click Download (To DTM) button to download it to DTM device. User must 

record the device ID of each device and never mix them up. 

 

Question: What to do if user forgot the communication parameters and passwords? 

Answer: Power off DTM device, press on “+” and “-” at the same time and then power on DTM, keep pressing 

on “+” and “-” for about 10 seconds until the 5 LEDs blink at the same time. After above operations, DTM 

communication and password will be reset to factory default settings: 

 Baud Rate: 9600bit/s 

 Parity Bit: None 

 Stop Bit: 2 bits 

 Device ID: 63 

 Configuration Password: 1234 

 Control Password: None 

For more information, please refer to the DTM-CFG User Manual and DTM Hardware User Manual. 

 

DM200 Configuration with DM200-CFG Software 
CAUTION: To set the device ID, ensure the computer connects one DM200 device only. If multi-devices are 

connected, please disconnect the connection between the computer and other devices. And note that the 
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computer could connect multi-devices when it is not in process of device ID setting. 

When configuring the DM200 device, we recommend that the computer connects one DM200 device only! Run 

DM200-CFG software, and then select Module ID Setup command from Module-Configuration menu. Then 

type 63 (factory default setting) in field of DM200 ID and click OK button to exit the window. 

Then select Communication Setup command from Communication menu to launch the “Communication 

Setup” window. Click Auto Search button on this window to launch the “Communication” window. On 

“Communication” window, you could select “Auto” from left pane to let computer automatically scan the 

available COM port, and then select “Manual” from right pane to set communication parameters manually. We 

strongly recommend that user sets the baud rate of DM200 device as 38400bps or 115200bps. Finally 

click Auto Search button to test the communication between the software and DM200 device. Once the 

communication is successful, the software will launch a message window to inform you. 

After successfully connecting the software and DM200 device, you can re-set the configuration parameters 

and then download it to DM200 device. Since all DM200 devices were specified the same DM200 ID (default is 

63) when they left the factory, you must re-specify the slave address of each DM200 device so that the system 

can work normally. Re-select Module ID Setup command from Module-Configuration menu, then type a 

number which must be integer between 0 and 255 in the DM200 ID field and all devices in the same system 

must be given a unique device ID, and later click Download button to download it to DM200 device. User 

must record the device ID of each device and never mix them up. 

 

Question: What to do if user forgot the communication parameters and passwords? 

Answer: Power off DM200, press on “+” and “-” at the same time and then power on DM200, keep pressing on 

“+” and “-” for about 10 seconds until the 5 LEDs display 66666 and blink at the same time. After above 

operations, DM200 communication and password will be reset to factory default settings: 

 Baud Rate: 9600bit/s 

 Parity Bit: None 

 Stop Bit: 2 bits 

 Device ID: 63 

 Configuration Password: 1234 

For more information, please refer to the DM200-CFG User Manual and DM200 Hardware User Manual. 
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System Configuration with PCM360 Software 

Preparation before the Configuration 

Make sure the following: 

 Your system is properly connected: All devices are correctly connected and reconfigured with a unique 

device ID. You could refer to System Layout Diagram and System Field Wiring Diagram. 

 Software that relates to the system is installed. Especially for the system that use MS SQL Server 2008 

WorkGroup edition, ensure it has been configured correctly. 

 PCM360 Server software is running. If your Purchase Order includes the services provided by PCM360 

software, ensure all services are started. 

 Since there is a demonstration database provided by PCM360 software, to avoid some unpredictable 

problems and make the system work normally, you must remove the demonstration database. Follow the 

steps below to remove the demonstration database: 

1. Run PCM360 DAQ&COM software (default user name: administrator; password: password) and 

stop the DAQ module. 

2. Select Device Management command from Setup menu. Delete all devices listed on the “Device 

Management” window. 

3. Select Plant Setup command from Setup menu. Delete all plants listed on the “Plant Setup” window. 

4. Exit PCM360 DAQ&COM software and run PCM360 DBM software (default password: password). 

5. Click Delete Data button and delete all history data. 

6. Exit PCM360 DBM software. 

Following contents will guide you through the steps to configure the whole system. For more information 

concerning PCM360 software operation, please refer to the online Help. 

 

Add DW Devices 

Select Windows Start->All Programs->PCM360 Plant Condition Management System->PCM360 

DAQ&COM command to run DAQ&COM software (Default user name: administrator; password: password). 

After it run, click  on toolbar to stop this module. Then select Device Management command from Setup 

menu. On “Device Management” window, click Add button. 
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On the “Add Device” window, type the device name, device No. (The software will automatically specify an 

unused No.). Then select “Modbus RTU” or “Modbus TCP Client” from “Device Type” field and select “DAQ 

Module for DW” from “Device Property” field. Later click OK button. Contents below show the extended 

definition for DW devices. The PCM360DW system supports up to 240 DW devices. 

 

 DW devices via Modbus RTU 

On “Device Management” window, select the DW device with device type of “Modbus RTU” and then click 

Extended Definition button. Then “Communication Setting” window is launched. See picture below. 

 

Slave Address: A field which allows multiple devices to share the same computer. These devices would be 

connected to the same COM port but would be distinguished by their individual slave address. For DW 

devices, slave address is always set by the configuration software of the related device. You should type 

correct slave address of the current device in this field. 

COM Selection: Select an available COM port and click Setup button. “COM Port Setting” window appears. 

Set proper communication parameters and click OK button. 
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Auto Scan (Button) 

The function is used to automatically test the communication between software and hardware device. When 

scanning succeeds, the communication parameters will be refreshed. 

NOTE: Before communication parameters are scanned automatically, ensure that slave address and channel 

register address of device are correctly set. 

 

Scan (Button) 

NOTE: Before the communication parameters are scanned, ensure that slave address and channel register 

address of device are correctly set. 

Click this button to launch “Communication” window. 

 

 Port: List the available COM ports on DAQ Server. 

 Auto: If selected, PCM360 will automatically scan the available COM port. 

 Manual: If selected, you should select a COM port from “Port” combo box. 

 BaudRate, Parity Bit, Stop Bit 

 Auto: If selected, PCM360 will automatically scan the proper communication parameters. 

 Manual: If selected, you should manually set the communication parameters. 

Auto Search (Button): Click this button to let software automatically scan the available port and proper 

communication parameters. If scanning succeeds, all communication parameters will be refreshed. And if it 

fails, a failed window will be launched to inform you. 

 

 DW devices via Modbus TCP 

On “Device Management” window, select a DW device and click Extended Definition button. Then “Server 
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Setting” window is launched. See picture below. 

 

Server Address: Type the IP address of the current Modbus RTU-TCP Converter unit that connects the DW 

devices. 

Advanced Setting (Button): Click this button to launch “Advanced Setting” window. 

 

 Slave Address: Type the slave address (also called slave ID or device ID) of the current DW device. 

 Server Port: The port that is used by PCM360DW and Modbus RTU-TCP Converter to communicate 

with each other. The default is 502. 

Connection Testing (Button) 

NOTES: Before test the connection, please ensure the following: 

1. The wiring between Modbus RTU-TCP Converter unit and DW devices are correct (Refer to Modbus 

RTU-TCP Converter of this manual), or else the device can’t work normally. 

2. The Modbus RTU-TCP Converter unit was configured by MGate Manager software. The communication 

parameters of the Modbus RTU-TCP Converter unit must match those of DW devices. 

Click this button, and then PCM360DW will try to connect the DW device. The communication result will be launched later. 

 Modbus Group Virtual Device 

The DTM of ProvibTech, which has only one channel, can be organized as one virtual device with two channels, 

which called Modbus Group device，the DTM of a modbus group device called ‘Unit’ 。 

If there are Modbus Groups in a PCM360 System, the device number from 128 to 255 will reserved for ‘Unit’ ， forbid to 

assign to other type of device。A Modbus Group and its units must be assigned continues device number, the first unit has 

the same device number to the Modbus Group device it belongs.  

Select  a Modbus Group device，click the button extent，the Unit Manager will pop up as follows: 
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Choose RTU or TCP mode according to the actual. Note only one mode for a DAQ node is permitted. 

Click the button named ‘Add Device’,，the ’Device Information’ window will popup as follows: 

 

The device numbers for the units will auto arrange and cannot be reassigned, but you can name the unit as your will. Click 

the button ‘OK’, the unit will be added to the Device List one by one.  
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Select one unit and click the button ‘Extent’, refer pre part for the RTU device or the TCP Client device to setup the 

commutation parameter for every unit. Select one unit and click the button name ‘Delete Device’, the unit will be deleted. 

Select one unit and click the button ‘Upload’ to upload the parameter of the unit, the parameter will show in the list at 

bottom of the window. 
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Upload Parameters from DW Devices 

Select Upload Local Device Parameters command from Setup menu (ensure DAQ module is stopped). DW 

devices added on local DAQ Server are listed. 

 

Select a device from the list, and then Upload button is enabled. Click this button and software will upload the 
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parameters from the hardware device. 

Before uploading the device parameters, please ensure the hardware device and DAQ module can 

communicate with each other properly. For example, select DTM and click Upload button. If the uploading 

succeeded, you will see picture below and you could go to “Channel Setup” window to check the channel 

parameters of this device. 

 

Picture below shows the channels information of DTM on “Channel Setup” window when parameters were 

uploaded successfully. 

 

CAUTION: If the DW device is reconfigured, you must re-upload the parameters; otherwise, the DAQ module 

can’t collect data from the device. 

 

Set DW Device Channel 

Select Channel Setup command from Setup menu (ensure DAQ module is stopped) and select a DW device 

from “Select Device” combo box. After uploaded parameters from the DW device, the device channel will be 

displayed on “Channel Setup” window; moreover, most parameters of the channel are defined and can’t be 

changed. 
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 Parameters Descriptions 

Running Speed on “Channel Setup” window: Type running speed of machine the current DW device 

channels are mapped to. 

NOTE: The running speed is in effect only when there is no phase reference channel under the current DW 

device. If there is phase reference channel, the running speed you typed on Phase Reference Parameter tab 

will take effect. See picture below: 

 

Enable (Check box): Make it to let the channel work. 

 

 Channel Definition of DTM 

By default, two channels are defined for the DTM device. Channel 0 is defined as a general continuous analog 

channel to get both dynamic data and static data while channel 1 is used as a phase reference channel to get 

phase reference signal. To change the channel parameters, select the channel and then click Channel 

Definition button. 

 

For channel 0, on General tab, you can change the channel description and set the transducer orientation 
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according to field requirement; for channel 1, you could set the running speed and rotation direction of the 

machine on Phase Reference Parameter tab. See pictures below: 

     

NOTE: To provide phase reference signal, DTM device needs to be specially wired. Refer to System Field 

Wiring Diagram. 

 

 Channel Definition of DM200 

By default, three channels are defined. Channel 0 and channel 1 are defined as general continuous analog 

channels to get both dynamic data and static data, while channel 2 is used as a phase reference channel to get 

phase reference signal. To change the channel parameters, select the channel and then click Channel 

Definition button. 

 

For channel 0 and channel 1, on General tab, you can change the channel description and set the transducer 

orientation according to field requirement; for channel 2, you could set the running speed and rotation direction 

of the machine on Phase Reference Parameter tab. 
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NOTE: To provide phase reference signal, DM200 device needs to be specially wired. Refer to System Field 

Wiring Diagram. 

 

Add Plant 

Select Plant Setup command from Setup menu (make sure DAQ module is stopped). On “Plant Setup” 

window, click Add button to launch the “Add Plant” window. 

 
Enter the plant name and then click Select Picture button to specify a picture for this plant. Finally click OK 

button to save the information. Note that the acceptable picture type is .bmp. 

 

Add Machine Train 

Select Machine Train Setup command from Setup menu (make sure DAQ module is stopped). On “Machine 

Train Setup” window, select a plant from the list and then click Add button to launch the “Add Machine Train” 

window. 



PCM360DW Condition Management System 
 
 
 

ProvibTech      Phone: +1-713-830-7601 Fax: +1-281-754-4972 sales@provibtech.com, www.provibtech.com 
71 

 

Enter machine train name and click Select Picture button to specify a picture for the new machine train. Finally 

click OK button to save the information. Note that the acceptable picture type is .bmp. 

 

Add Machine 

Select Machine Setup command from Setup menu (make sure DAQ module is stopped). On “Machine Setup” 

window, select a machine train from the list and then click Add button to launch the “Add Machine” window. 

 

Enter machine name and then click Select Picture button to select a picture for this machine. Finally click OK 

button to save the information. Note that the acceptable picture type is .bmp. 

 

Add Measurement Point 

Select Measurement Point Setup command from Setup menu (make sure DAQ module is stopped). On 

“Measurement Point Setup” window, select a machine from the list and then click Add button to launch the 

“Add Measurement Point” window. 
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Enter the name and then select the picture type for the new measurement point. DAQ&COM software will 

automatically specify a picture that related to this type. Finally, click OK button to save the information. 

 Acc: For measurement points that connect acceleration transducer. 

 Vel: For measurement points that connect velocity transducer. 

 Proximity Probe: For measurement points that connect proximity probe. 

 Other: For measurement points that connect other types of transducer. 

Note that PCM360DW system is capable of monitoring maximum 3200 measurement points. 

 

Map DW Device 

Mapping is the process of linking a data source to a measurement point. The operation of “Map DW Device” 

links a monitored location on a machine train with hardware device that is actually collecting the data. Select 

Mapping DAQ Device command from Setup menu. 

 

Mapping Status: Mapped indicates the machine train has mapped DAQ devices while Un-mapped indicates 

the machine train hasn’t mapped any DAQ devices. 

To map a DW device with the machine train, select the machine train and then click the Mapping DAQ Device 

button. 
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Select the DW device from Un-mapped Device List and then click  to move it to Mapped Device List. Note 

that a machine train only maps the DW devices that connect the same DAQ Server, i.e. the DW devices that 

are mapped by a machine train must have the same IP Address. 

 

Map DW Device Channel 

Mapping is the process of linking a data source to a measurement point. Select Mapping DAQ Device 

Channel command from Setup menu. 

To map DW device channel with measurement point channel: 

1. On “Mapping DAQ Device Channel” window, select a measurement point and then click Mapping button. 

“Mapping Channel” window is launched. 

2. Select the DW device, and then the un-mapped channels under the device are displayed. 

 

Select a measurement point channel (for example: Channel X) and meanwhile select the DW channel, and 

then click the activated  button. 

 

 

If the selected measurement point has two channels, repeat the step to map Channel Y. 

 

3. If there is phase reference channel under the device, mark “Phase Reference Channel” and then select a 
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phase reference channel from the list. 

 

4. After finished the mapping operation, click OK button to save the information. 

 

Set Static and Dynamic Data Collection Conditions 

Select Static and Dynamic Data Collection Setup command from Setup menu. On this window, you can set 

trigger conditions for the machine train to collect static and dynamic data. 

 

Select the machine train and then check the trigger modes, finally click OK button. 

 

 Alarm Trigger 

“Alarm Trigger” means when alarm occurs on a channel that belongs to the machine train, channels under this 

machine train will start to collect dynamic or/and static data (one sample per triggering). The data collection 

will be started only when the alarm severity of the measured value of the related measurement point 

channel changed. The change could be an alarm severity conversion from Normal to Alarm (Alert or 

Danger), or Alarm (Alert or Danger) to Normal, or Alert to Danger, or Danger to Alert. Channels that could 

be alarm-triggered must set “Enable Alarm” function on Measurement Parameter tab. See picture below: 
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 Band Alarm Trigger 

The function doesn’t apply to DW channels. 

 

 Time Trigger 

In this trigger mode, you should set the start time and time interval for both static and dynamic data collection. 

When the time trigger condition for static data collection is matched, only static data is collected; but when the 

time trigger condition for dynamic data collection is matched, both dynamic data and static data are collected. 

 

Define Status 

The function is used to define statuses for machine trains and dynamic samples. Select Define Status 

command from Setup menu (ensure DAQ module is stopped). 

 
Click Add button on the “Define Status” window to add new status. Type the status name in edit box and then 

click OK button. The name can be up to 31 characters long. You are allowed to define up to 255 customized 

statuses. 
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After added all statuses you need, you could set the status for the machine train and the dynamic sample. See 

System Configuration with PCM360 Software/Set Machine Train’s Status and PCM360DW System 

Operation/Define Dynamic Sample’s Status for details. 

NOTE: If the status name is changed, the new name will apply to the entire system. 

 

Set Machine Train Status 

The function is used to set status for each machine train in PCM360DW system. 

 

Select a machine train from the list and click Set Status button to specify a status for the current machine train. 

All statuses you added on “Define Status” window will be displayed in “Machine Train’s Status” combo box. 

When the machine train is triggered to collect data after the status was set, the collected static and/or dynamic 

data will be labeled this status. 

Custom the picture of the device 

Custom picture of the devices can be added to the device picture library of PCM360. 

Select Edit Device Picture command from Setup menu, the PCM360 will start the Paint accessory. A bitmap 
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file named ‘kong’ will be setup and the current directory will be assigned to the directory of  the device picture of 

the PCM360 system (/PCM360/Picture).Draw the picture for a plant, train or machine, save and named the 

bitmap as your will, the extent device picture will be valid latterly. 

There is alternate way to extend the device picture library: copy the custom picture of the device to the 

directory of the device picture of the PCM360 system (/PCM360/Picture) directly. 

Set FFT Window 

Select FFT Window Setup command from Setup menu to open “FFT Window Setup” window (ensure the 

DAQ module is stopped). 

 

In this dialog box, you should select an appropriate window that will be applied to the waveform sample before 

it undergoes FFT analysis. The choices are: Rectangular, Hamming, Hanning, and Blackman. By default, 

PCM360DW system will specify Hanning as the FFT window. 

 

Set Network 

Select Network command from Setup menu to change setting on network selection of PCM360DW system 

(ensure DAQ module is stopped). The default is Network. If you want to change it to Stand-alone, select 

“Stand-alone” and then click OK button. Finally, restart DAQ module on local DAQ Server. 
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Set System Unit 

Select Unit Setup command from User menu. (Be cautious that the configuration of the DAQ should be in the 

same units of Metric/English as selected for the display on the screen). 

 

Select “English” or “Metric”, and then click OK button. 

Change the size of the font of the measurement points 

Select Measure Point Font... command from User menu, the dialog for adjusting the size of the font of the 

measurement points will popup as follow: 

 

Drag the slider and release, click the button OK, the size of the font of the measure points will change. 

Define PCM Explorer 

Select Define PCM Explorer from User menu (Ensure DAQ module on local computer is started). 
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Selected Machine Train (List): List machine trains that are displayed on PCM Explorer of the current logon 

user. 

Available Machine Train (List): List machine trains that are monitored by PCM360 system but not displayed 

on PCM Explorer of current logon user. 

: Left shift button. 

: Right shift button. 

The PCM Explorer is empty when you first log on PCM360 DAQ&COM. After finished the system configuration, 

you should add the concerned machine trains on the PCM Explorer by moving them from “Available Machine 

Train” list to “Selected Machine Train” list. 

 

Edit Picture 

After you finished configuring plants, trains, machines, and measurement points, you should select Define 

PCM Explorer command from User menu to display the related trains on PCM Explorer. And then you could 

edit pictures for all plants, machine trains, machines and measurement points in the current user PCM 

Explorer. 

Example: The next lines guide you through the steps to configure Plant-Machine train view, Machine 

train-Machine view and Machine train-Machine-Measurement point view. Following table shows you the 

relationship between the plant, machine train, machine, and measurement point. This is only an example. 

Plant Machine Train Machine Measurement point 
Plant-Rutherford Generator1# Gear1# ACC 
Plant-Rutherford Generator1# Gear1# VIB 
Plant-Rutherford Generator1# Gear2# VEL 
Plant-Rutherford Generator1# Gear2# OTH 
Plant-Rutherford Generator2# Gear3# Acc 
Plant-Rutherford Generator2# Gear3# Vib 
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Plant-Rutherford Generator2# Gear4# Vel 
Plant-Rutherford Generator2# Gear4# Oth 

 

 Configure Plant-Machine train view 

1. Select Plant-Rutherford from tree view. See current PCM Explorer: 

 

2. Select Edit Picture from Edit menu to make it checked; 

 

3. Drag machine train pictures and move them to proper location on plant picture; 

 

4. Right click the picture of machine train Generator 2#, and select Link Machine Train command; 
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And click anywhere on the picture of Generator 1#. See picture below: a line that starts with picture of 

Generator 2# and ends with Generator 1# is displayed. 

 

 

 Configure Machine train-Machine-Measurement point view 

1. Select Generator1# from tree view (or double click picture of Generator1# on Graphics View). See 

Graphics View about Generator1#; 

 

2. Drag pictures of machines and measurement points beneath Generator1# to the proper location. (Ensure 

Edit Picture from Edit menu is checked); 
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3. Right click picture of Gear 2# and select Link Machine command; 

 

Click anywhere on picture of Gear 1#. See picture below: a line that starts with picture of Gear 2# and ends with 

Gear 1# is displayed; 

 

4. Right click picture of measurement point OTH and then select Stud on Machine command; 

 

Since OTH belongs to machine Gear 2#, click anywhere on picture of Gear 2#, and then OTH is fixed on Gear 

2#. See picture below: 
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Repeat operations mentioned above to configure other Machine train-Machine-Measurement point View. 

CAUTION: To apply all configurations on Graphics View, before the PCM Explorer is refreshed, you should 

select Edit Picture from Edit menu to make the command unchecked. Or else, the configuration information 

will be lost. 

 

Other functions: 

 Withdraw the linking between two machine trains and two machines 

Answer: Take Generator 1# and Generator 2# as an example. We have linked Generator 1# and Generator 

2#. The line started with picture of Generator 2# and ended with picture of Generator 1#. Follow the steps 

below: 

1. Select Edit Picture from Edit menu to make it checked. If the command is already checked, skip the step 

and directly go to step 2; 

2. Right click picture of Generator 2# and select Link Machine Train command; 

 
3. Click anywhere beyond picture of Generator 1#. After that, the line between pictures of Generator 2# and 

Generator 1# will disappear. 

The method mentioned above also applies to withdraw lines between two machines. 
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 Hide or show measurement points on Machine Train-Machine-Measurement point View and 

Machine-Measurement point View 

Answer: Ensure Edit Picture from Edit menu is not checked. On the view, right click picture of machine, and 

then select Show All Measurement Points or Hide All Measurement Points command. After that, 

measurement points that belong to the machine are shown or hidden. 

 

 Hide a single measurement point beneath the machine 

Answer: Ensure Edit Picture command from Edit menu is unmarked. On Machine train-Machine View or 

Machine-Measurement point View, right click this measurement point and select Hide command from 

shortcut menu. 

 

 

 Zoom in or zoom out pictures of machine train and machine 

Answer: Take picture of machine Gear 2# as an example. Ensure that Edit Picture from Edit menu is marked. 

Rest the mouse pointer on the side edge of the picture, for example, on the right side. When the mouse pointer 

changes to a straight double-arrow, to zoom in picture of Gear 2#, you should drag the picture to the outside 

direction, in this example you should drag it to the right side. And to zoom out picture of Gear 2#, you should 

drag the picture to the inside direction, in this example you should drag it to the left side. Pictures of machine 

trains and machines can be zoomed in or zoomed out from 4 directions (up, down, left and right). 

 

Add New User  

Select User Account Management command from User menu. Then click Add button on the “User Account 

Management” window. Note that only administrator has right to add new user. 
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Enter user name, password, confirm password in the related edit boxes, and then select user level. 

PCM360DW system provides three levels of user access: administrator, Super user, and User. Administrator 

is the highest level of user access and has full access to operate PCM360DW system. User with this right must 

be well trained and be knowledgeable of this field. Operation of deleting administrator is not allowed. Super 

user almost has full access to operate the system, but it can’t manage user accounts information, set PCM360 

services properties and maintain system database. User with Super User rights also should be well trained and 

be knowledgeable about the operation of the software. User is the lowest level of user access. It only has 

access to define PCM Explorer and view plots. 

 

Change Logon Password of the Current User 

Select Modify Password command from User menu to open “Modify Password” window. You are required to 

enter the original password and new password (twice). 

 

 

Set System No. 

By default, the system No. is set to “0”. If user wants to specify another No. for the current system, select 

System No. Setup command from Setup menu. 



PCM360DW Condition Management System 
 
 
 

ProvibTech      Phone: +1-713-830-7601 Fax: +1-281-754-4972 sales@provibtech.com, www.provibtech.com 
86 

 

System No. is used to identify the unique PCM360DW system when there are multi-PCM360DW systems in 

the same local network. 

CAUTION: To apply the new system No., after re-specify the system No., you must exit PCM360 software 

(contains DAQ&COM, Display, Server, and Web Server) on all PCM360 Terminals, and then re-run them. 

 

Backup Your System 

Note that after you finished configuring the PCM360DW system, we strongly recommend that you backup your 

system configuration data so that you can rebuild the database when it is destroyed or lost for some 

unpredictable reasons. 

Run PCM360 DBM software (Ensure both the SQL Server service and SQL Server Agent service are started). 

Click Backup DB button on the main window to open “Backup Database” window. 

 

Check “Manual” option and click  to select a backup path. Then click OK button. Software will launch the 

prompt dialog box shown below. 
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Click OK button to complete the operation. If succeeded in backing up the database, the backup file will be 

saved in the path you set. 

For detailed operation of the DBM software, please consult the online Help. 
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PCM360DW System Operation 

This part mainly focuses on the plot parameter settings and plots display of the system. All operations are 

executed on PCM360 Display software. For more information about this software, please consult the online 

Help. 

 

Run PCM360 Display Software 
Select Windows Start->All Programs->PCM360 Plant Condition Management System->PCM360 

Display. On “User Logging On” window, type the proper user name (default is “administrator”) and password 

(default is “password”), and then click OK button. 

 

 

DB Server Selection (Button) 

Click this button to change the DB Server PCM360 Display software connects to. 

 

Type the name or IP address of DB Server, and click OK button. 

 

Set Plot Parameter 
Select Plot Parameter Setup command from User menu and following window is launched. 
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Trend Depth: It is the maximum number of the points that generate a trend plot. Maximum trend depth is 2000. 

Waterfall Depth: It is the maximum number of the spectrum plots to be displayed on a waterfall plot. Maximum 

waterfall depth is 20. 

Transient Depth (Bode/Polar/Cascade): This property doesn’t apply to PCM360DW system. 

Maximum Frequency in Waterfall and Cascade: It is the maximum frequency domain on cascade and 

waterfall plot. Maximum value is 10000. 

Maximum Points in Shaft Centerline: This property doesn’t apply to PCM360DW system. 

Frequency Unit: Set the units of frequency for display on the related plots. The options are Hz, RPM, and NX.  

NX: NX indicates the signal’s frequency component that equals to the n times of the machine’s actual rotative 

speed. N should be a real number between 0.001 and 10. 

 

Set Frequency and Compensation 
Select Frequency and Compensation Setup command from User menu. 

 
Since compensation feature doesn’t apply to PCM360DW system, from the Plot List, select the plot that 
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support the frequency component settings, and then click Setup button to choose the he signal’s frequency 

component to generate the plot. 

Plots supporting frequency component display: 

 Waveform 

 Shaft XY Vibration 

 Trend 

The available options are All, 1X, 2X, NX, and NOT1X. 

 
 All: In a complex vibration signal, notation for signal with all frequencies components. 

 1X: In a complex vibration signal, notation for the signal component that occurs at the actual rotative 

speed frequency. 

 2X: In a complex vibration signal, notation for signal component having frequencies equal to two times of 

actual rotative speed frequency. 

 NX: In a complex vibration signal, notation for signal component having frequencies equal to N times of 

actual rotative speed frequency while N is user definable. 

 NOT1X: In a complex vibration signal, notation for signal components with 1X frequency component 

filtered out. 
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Set Plot Group 

 

 Measurement Point Plot Group: 

Define plot group window for the measurement point. To display the plots on the measurement point’s plot 

group window, you should mark the check box before the plots. Available options are waveform(R), 

spectrum(R), shaft XY Vibration(R), and trend(R). Picture below shows you a measurement point’s plot group 

window. 

 
 Sample Plot Group: 

Define plot group window for the dynamic sample. To display the plots on the sample’s plot group window, you 

should mark the check box before the plots. Available options are waveform, spectrum, and shaft XY vibration. 

Picture below shows you a sample’s plot group window. 
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 Transient Plot Group: The feature doesn’t apply to the PCM360DW system. 

 

Start Static and Dynamic Data Acquisition 
Ensure both DAQ and Display modules are started. From the tree view select the machine train, then directly 

click  on toolbar (or select Start Static and Dynamic Data Acquisition command from Operation menu) 

to manually trigger the measurement points under the selected machine train to collect static and dynamic 

data. As a result, a static sample and a dynamic sample are collected during a data collection. 

 

Acknowledge Alarm 
The function allows user to acknowledge all alarms of machine trains. When alarm occurs, the function is 

activated (shortcut icon  on toolbar is enabled), and meanwhile, the pictures’ color bars of the alarmed 

machine train, machine and measurement point start to flash. 

Click  button on toolbar or select Acknowledge Alarm command from Operation menu, and then following 

window is launched. 
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All alarmed machine trains will be listed on the window above. Mark the check box before the machine train 

and click Acknowledge Alarm button to acknowledge the alarm of this machine train. By default, “Select All” 

will be marked, and clicking Acknowledge Alarm button will acknowledge alarms of all machine trains. When 

alarm is acknowledged and the alarm status of related machine train returns to normal, the picture bar of the 

alarmed machine train will stop flashing. 

 

Define Baseline 
Baseline sample is a dynamic collection of data that is taken at a particular time to provide sample data for a 

particular machine condition. You can compare other samples with this baseline sample under the same 

measurement point to see if they have deviated enough to cause concern. 

Define Baseline sample: Ensure Display module is started. Select a dynamic sample under a measurement 

point, and then select Define Baseline command from Operation menu (or right click this sample and then 

select Define Baseline from shortcut menu). The baseline sample is marked with red symbol BL just like 

picture shown below. 

 

NOTE: User could only define one baseline sample for a measurement point. 

 

Define Dynamic Sample Status 
The command is used to set status for dynamic sample. Ensure Display module is stopped. From Dynamic 

Data list view, select a dynamic sample, and click Define Sample Status command from Setup menu. “Define 
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Sample Status” window is launched. 

 

On the window above, specify a status for the sample and then click OK button. You can view the status 

information of the data on Graphics View by details display mode. 

NOTE: If you change the status of the sample to “None” status, the sample’s former status information will be 

deleted i.e. the sample will has no status. 

 

Select Status for Historical Data View 
The function allows user to only view the historical data labeled the selected status. Select this command from 

User menu, and then “Select Status for Historical Data View” window is launched. 

 

Status for Historical Data: List all data statuses user defined on “Define Status” window on PCM360 

DAQ&COM software. 

On “Select Status for Historical Data View” window, when a status is selected, all historical data (static and 

dynamic) with this status will be displayed on Graphics View, and others will automatically be filtered out. For 

example: Select “Steady Running” status, and the software will only display the historical data with “Steady 

Running” status of all machine trains. 
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Moreover, most plots generated by these historical data will show the status on the plots. It is very convenient 

for user to analyze the data that have something in common and machine running status in some specific 

conditions. 

NOTES: 

1. Display software will display historical data with all status by default when you first run the software. 

2. The function applies to all machine trains in the system. 

 

Add Note 
The function allows user to attach a special description to the dynamic sample for future viewing. 

Select an available sample, and click Add Note command from Operation menu (or right click the sample and 

select Add Note from shortcut menu). Then a yellow note will be launched and user can type comments of the 

selected sample. Finally click  button on the note to save the comments. 

 

After added a note for a sample, the Note column will show “Yes” in dynamic data list view displayed by details 

mode. 
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NOTES: 

1. Each dynamic sample could be added only one note. 

2. User is allowed to add a note for the sample when viewing its historical waveform, spectrum and shaft XY 

vibration plots (right click the plot and select Add Note from shortcut menu). 

 

Show Note 
The command is used to view and modify the note of the sample. 

Select the sample that has a note and then click Show Note command from Operation menu (or right click the 

sample and select Show Note from shortcut menu). Then a yellow note will be launched and user can modify 

the comments of the selected sample. Finally click  button to save the note. 

NOTE: User is allowed to show and modify the note when viewing historical waveform, spectrum and shaft XY 

vibration plots of the sample (right click the plot and select Show Note from shortcut menu). 

 

Delete Note 
The command is used to delete the note of the sample. 

Select the sample that has a note and then click Delete Note command from Operation menu (or right click 

the sample and select Delete Note from shortcut menu). Then a message box will be launched. Click Yes 

button to confirm to delete the note. 

NOTE: User is allowed to delete the note when viewing historical waveform, spectrum and shaft XY vibration 

plots of the sample (right click the plot and select Delete Note from shortcut menu). 

 

Waveform 
Waveform plot is a presentation of the instantaneous amplitude of a signal as a function of time. Waveform plot 

applies to all dynamic samples. To display sample’s waveform plot, ensure Display module on local computer 

is started. Select a dynamic sample first, and then select Waveform command from Plots menu (or directly 

click  on toolbar; or right click the sample and select Waveform from shortcut menu). Picture below shows a 

waveform plot with both channel X and channel Y. 



PCM360DW Condition Management System 
 
 
 

ProvibTech      Phone: +1-713-830-7601 Fax: +1-281-754-4972 sales@provibtech.com, www.provibtech.com 
97 

 

Plot Features: 

 On waveform curve, points that are marked by pink color are phase reference. 

 Auto full scale the waveform: Click  on toolbar. 

 Magnify or restore the waveform: Use  or  on toolbar. 

 View waveform of different frequency components: Click , ,  on toolbar, or select the related 

commands (All Frequency, 1X, 2X, NX, NOT1X) from View menu. 

 Display/hide waveform of channel X (channel Y): For waveform generated by dynamic or transient 

sample under the dual-channel measurement point, by default the Display software will show waveform 

plots of both channel X and channel Y. To view single channel’s waveform plot, click  or  on toolbar. 

 Display/hide waveform of baseline sample: If the baseline sample for this measurement point is 

specified, clicking  and  on toolbar will display baseline waveform plots of channel X and channel Y. 

 Add note for the sample: Click Add Note command from Operation menu (or right click the plot and 

select Add Note from shortcut menu). 

 Show the note on plot: To view or edit the sample’s note on the plot, click Show Note command from 

Operation menu (or right click the plot and select Show Note from shortcut menu). 

 Select different point on waveform curve: Press Left or Right key on keyboard. 

 Save plot as *.bmp format: Click Save as *.bmp command from File menu. 

 

Spectrum 
Spectrum plot is commonly a presentation of the amplitudes of a signal’s frequency components versus their 

frequencies. Spectrum plot applies to dynamic samples. To display sample’s spectrum plot, ensure Display 
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module on local computer is started. Select a dynamic sample first, and then select Spectrum command from 

Plots menu (or directly click  on toolbar; or right click the sample and select Spectrum from shortcut menu). 

Picture below shows a spectrum plot with both channel X and channel Y. 

 

Plot Features: 

 Auto full scale the spectrum: Click  on toolbar. 

 Magnify or restore the spectrum: Use  or  on toolbar. 

 Display/hide spectrum of channel X (channel Y): For spectrum generated by dynamic or transient 

sample under the dual-channel measurement point, by default the Display software will show spectrum 

plots of both channel X and channel Y. To view single channel’s spectrum plot, click  or  on toolbar. 

 Display/hide waveform of baseline sample: If the baseline sample for this measurement point is 

specified, clicking  and  on toolbar will view baseline spectrum plots of channel X and channel Y. 

 View harmonics/sideband/band alarm line/full spectrum plot: Click the related command from View 

menu (or right click the spectrum plot and then select the related command from the shortcut menu). For 

more information concerning these commands, please consult the online Help. 

 Add note for the sample: Click Add Note command from Operation menu (or right click the plot and 

select Add Note from shortcut menu). 

 Show the note on plot: To view or edit the sample’s note on the plot, click Show Note command from 

Operation menu (or right click the plot and select Show Note from shortcut menu). 

 Select different point on waveform curve: Press Left or Right key on keyboard. 

 Save plot as *.bmp format: Click Save as *.bmp command from File menu. 
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Shaft XY Vibration 
Shaft XY vibration is two dimensional path of the shaft centerline motion perpendicular to the rotor axis during 

precession. The curve can be observed with an oscilloscope in orbital mode connected to XY vibration 

measuring transducers. Shaft XY vibration only applies to dynamic samples under the dual-channel 

measurement points. CAUTION: The two channels of a measurement point must map the same type of DW 

channel. 

To display sample’s shaft XY vibration plot, ensure Display module on local computer is started. Select a 

dynamic sample first, and then select Shaft XY Vibration from Plots menu (or directly click  on toolbar; or 

right click the sample and select Shaft XY Vibration from shortcut menu). Picture below shows a shaft XY 

vibration plot. 

 

Plot Features: 

 On the curve, points that are marked by pink color are phase reference. 

 Auto full scale the shaft XY vibration: Click  on toolbar. 

 View shaft XY vibration plot of different frequency components: Click , ,  on toolbar, or 

select the related commands (All Frequency, 1X, 2X, NX, NOT1X) from View menu. 

 Show SMax and Cross Cursor: Right click anywhere on the shaft XY vibration and select the related 

command from shortcut menu. 

 

By default, “Show Cross Cursor” is marked. Once this command is marked, the selected point on the 

curve will be marked by the cross cursor just like “+”. 

Show SMax: SMax is maximum RMS value of the points on the shaft XY vibration. Select this command 
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to display the SMax point on the plot. And the SMax information that contains amplitude and vector angle 

of the SMax point will also be shown above the plot. 

  

 Add note for the sample: Click Add Note command from Operation menu (or right click the plot and 

select Add Note from shortcut menu). 

 Show the note on plot: To view or edit the sample’s note on the plot, click Show Note command from 

Operation menu (or right click the plot and select Show Note from shortcut menu). 

 Select different point on shaft XY vibration: Press Left or Right key on keyboard. 

 Save plot as *.bmp format: Click Save as *.bmp command from File menu. 

 

Trend (Dyn) 
Dynamic trend plot is a presentation in Cartesian coordinates of a measured variable versus time, based on all 

dynamic samples under a measurement point taken over different times. To display dynamic trend plot, ensure 

Display module on local computer is started. From the tree view, select Dynamic symbol beneath the 

measurement point, and then select Trend (Dyn) command from Plots menu (or directly click  on toolbar; 

or right-click Dynamic symbol and select Trend (Dyn) from shortcut menu). Picture below shows a dynamic 

trend plot. 
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Plot Features: 

 Auto full scale the dynamic trend: Click  on toolbar. 

 Magnify or restore the dynamic trend: Use  or  on toolbar. 

 View dynamic trend plot of different frequency components: Click , ,  on toolbar, or select 

the related commands (All Frequency, 1X, 2X, NX, NOT1X) from View menu. When user views dynamic 

trend plot of 1X/2X/NX frequency component, Display software will also show the phase angle trend plot. 

 

 Display/hide dynamic trend of channel X (channel Y): For dynamic trend plot generated by dynamic 

samples under the dual-channel measurement point, by default the Display software will show dynamic 

trend plots of both channel X and channel Y. To view single channel’s dynamic trend plot, click  and  

on toolbar. 

 View trend plot within selected time range: User can view the trend plot in a time period. There are 

three methods to specify the time range. 

Method 1: Right click a point on the trend, and then select Set Starting Time from shortcut menu. The 

Time Slider Date and Time Picker
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time that relates to this point is specified as the starting time. Set the ending time in the same way and 

finally click Refresh button. 

Method 2: Mark “Starting time”, and directly select the time on the time slider. Then set the ending time in 

the same way and finally click Refresh button. 

Method 3: Mark “Starting time”, and orderly select date and time from date and time picker. Then set the 

ending time in the same way and finally click Refresh button. 

 View waveform and spectrum of the sample: Double click a point on the dynamic trend and then the 

waveform and spectrum plot of the sample associated with this point are displayed. By clicking  or  

on toolbar, user can view the waveform and spectrum generated by the previous or the next dynamic 

sample, and the point cursor on the trend plot will move at the same time. 

 

 Select different point on the dynamic trend curve: Press Left or Right key on keyboard. 

 Save plot as *.bmp format: Click Save as *.bmp command from File menu. 

 

Waterfall (Dyn) 
Dynamic waterfall plot displays a stack of spectrum plots, based on all dynamic samples under a measurement 

point taken over some period time. To display dynamic waterfall plot, ensure Display module on local computer 
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is started. From the tree view, select Dynamic symbol beneath a measurement point, and then select Waterfall 

(Dyn) command from Plots menu (or directly click  on toolbar; or right-click Dynamic symbol and select 

Waterfall (Dyn) from shortcut menu). Picture below shows a dynamic waterfall plot. 

  
 

Plot Features: 

 Auto full scale the dynamic waterfall: Click  on toolbar. 

 Display/hide dynamic waterfall of channel X (channel Y): For dynamic waterfall generated by 

dynamic samples under the dual channel measurement points, by default the Display software will show 

dynamic waterfall plots of both channel X and channel Y. To view single channel’s dynamic waterfall plot 

window, click  and  on toolbar. 

 View waterfall plot within selected time range: Similar to dynamic trend plot, user can view the 

dynamic waterfall plot in a time period. Two methods to specify the time range: 

Method 1: Mark “Starting time”, and directly select the time on the time slider. Then set the ending time in 

the same way and finally click Refresh button. 

Method 2: Mark “Starting time”, and orderly select date and time from date and time picker. Then set the 

ending time in the same way and finally click Refresh button. 

By default, the number of the spectrum curve on the dynamic waterfall depends on the waterfall depth. When 

you change the display time range of the waterfall plot, the spectrum number may change. For example, you 

set the waterfall depth to 20 and currently only 15 dynamic samples were collected within the display time 

range, under this condition, Display software will display the waterfall generated by 15 spectrum curves. 

 View waveform and spectrum of the sample: Double click a spectrum curve on the dynamic waterfall, 

and then the waveform plot and spectrum plot of the sample associated with the spectrum curve are 

Date and Time PickerTime Slider
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displayed. 

 

 Select different point on the same spectrum curve: Press Left or Right key on keyboard. 

 Save plot as *.bmp format: Click Save as *.bmp command from File menu. 

 

Waveform (R) 
Display real-time waveform: Ensure both the Display and DAQ modules are started. From tree view, select 

an available measurement point and then select Waveform (R) from Plots menu (or directly click  on 

toolbar; or right click this measurement point and then select Waveform (R) from shortcut menu). Picture 

below shows a real-time waveform plot. 
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The functions for historical waveform also apply to real-time waveform plot. See Waveform to get more details. 

 

Spectrum (R) 
Display real-time spectrum: Ensure both the Display and DAQ modules are started. From tree view, select 

an available measurement point and then select Spectrum (R) from Plots menu (or directly click  on 

toolbar; or right click this measurement point and then select Spectrum (R) from shortcut menu). Picture below 

shows a real-time spectrum plot. 

 

When you are viewing a spectrum, right click the plot and select Full Spectrum from shortcut menu (or select 

Full Spectrum command from View menu), and real-time full spectrum is displayed. See picture below: 

 

Some functions for historical spectrum plot also apply to real-time spectrum plot. See Spectrum to get more 

details. 

 



PCM360DW Condition Management System 
 
 
 

ProvibTech      Phone: +1-713-830-7601 Fax: +1-281-754-4972 sales@provibtech.com, www.provibtech.com 
106 

Shaft XY Vibration (R) 
Real-time shaft XY vibration applies only to dual-channel measurement points. 

Display real-time shaft XY vibration: Ensure both the Display and DAQ modules are started. From tree view, 

select an available measurement point and then select Shaft XY Vibration (R) from Plots menu (or directly 

click  on toolbar; or right click this measurement point and then select Shaft XY Vibration (R) from shortcut 

menu). Picture below shows a real-time shaft XY vibration plot. 

 

The functions for historical shaft XY vibration plot also apply to real-time shaft XY vibration plot. See Shaft XY 

Vibration to get more details. 

 

Trend (R) 
Real-time trend plot applies to all measurement points. 

Display real-time trend: Ensure both the Display and DAQ modules are started. From tree view, select the 

measurement point and then select Trend (R) from Plots menu (or directly click  on toolbar; or right click 

this measurement point and then select Trend (R) from shortcut menu). Picture below shows two real-time 

trend plots. 
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The features the real-time trend plots have are almost the same as the static trend plots. See Trend (Sta). 

 

Bar Graph 
Bar graphs are a popular format for displaying current measured value and statuses of channels. The color of 

the bar graph indicates the channel’s real-time alarm severity (the background color is blue). 

 Red: Danger 

 Yellow: Alert 

 Green: Normal 

Color status indication: 

 Flashing: The channel has ever alarmed and the alarm was not acknowledged yet. 

 Solid: On the channel, no alarm occurs or the alarm has been acknowledged. 

 

Display bar graph: Ensure both DAQ and Display modules are started. Select a node from tree view (the 

node could be a machine train, a machine, or a measurement point). Then directly click  on toolbar (or right 

click this node and then select Bar Graph from shortcut menu; or select Bar Graph from Plots menu). Picture 

below shows a bar graph of a machine train. 
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Plot Feature: 

 View real-time waveform and spectrum of channel: For channel that mapped DW devices, double 

clicking the bar graph of the channel will display the real-time waveform and real-time spectrum plot. 

 

CAUTION: Sometimes even though the channel’s real-time measured value doesn’t exceed the alarm set 

point, the channel is still in alarm severity. See picture below: 
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That indicates the device channel was set with “Alarm Latching” property, once the channel alarmed, it will 

keep the alarm status unless the device is reset. 

 

Status List 
Status list shows the real-time information concerning the machine train, machine and measurement point. 

View status list: Ensure both DAQ and Display modules are started. From tree view, select the machine train 

(or machine, measurement point) and then select Status List command from Plots menu (or right click the 

node and then select Status List from shortcut menu). Picture below shows a status list of a machine train. 

 
The real-time information shown on the list includes value type (Overall), real-time measure value, and alarm 

set points of the measured channel. 

 

Alarm List 
Alarm list shows the information concerning the alarm events of the machine train, machine, and measurement 

point. 

View alarm list: Ensure Display module on local Display Terminal is started. From tree view, select the 

machine train (or machine, measurement point) and select Alarm List from Plots menu (or right click this node 

and select Alarm List from shortcut menu). On the launched “Time Range” window, select the time range of 

the alarm events you want to view and then click OK button. 
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Picture below shows a total alarm list. 

 

Alarm list represents the alarm time of the alarm event, name of the alarmed channel, value type, the related 

measure value and alarm status, alarm set points, and the band alarm information. Each page of the list 

displays up to 20 records. Click the left or right arrow button to see records on the next or previous page. 

 Status column: Indicate the alarmed channel’s alarm severity. If the channel’s measure value exceeded 

the danger set point, the alarm severity of this channel will be “Danger” and if the channel’s measure value 

exceeded the alert set point but was less than danger set point, the alarm severity will be “Alert”. 

 Band Alarm column: Band alarm function doesn’t apply to DW device. 

 

CAUTION: Sometimes you may see that the channel’s alarm status is “Alert” or “Danger”, whereas the 

measured value doesn’t exceed alert set point. For example, see picture below: the channel’s overall is 0.15g, 

which doesn’t exceed alert set point with 0.30g, but its status is shown as “Alert” severity. 
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The case may occurs under the condition that the DW device channel was set with “Alarm Latching” property. 

And once the channel alarmed, it will keep the alarm status unless the device is reset. As you see in the list 

above, though the channel’s measure value is in normal range now, it still alarms. 

 

Plot Group (Sample) 
Click this command to view plot group of a dynamic sample. User defines the plot group on “Plot-Group Setup” 

window (select Plot-Group Setup command from User menu). 

Display plot group of sample: Ensure Display module is started. Select a dynamic sample first, and then 

directly click  on toolbar (or select Plot Group/Sample command from Plots menu). Picture below shows a 

dynamic sample’s plot group that contains waveform, spectrum and shaft XY vibration plots. 

 

When viewing plot group of the selected sample, you can navigate to plot group of previous or next sample 

under the same dynamic data set by clicking  or  on toolbar. 
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Plot Group (Measurement Point) 
Click this command to view a real-time plot group of a measurement point. User defines the plot group on 

“Plot-Group Setup” window (select Plot-Group Setup command from User menu). 

Display real-time plot group of a measurement point: Ensure both DAQ and Display modules are started. 

From tree view, select the measurement point and then directly click  on toolbar (or select Plot 

Group/Measurement Point command from Plots menu). 

 

When viewing plot group of the selected measurement point, you can navigate to plot group of previous or next 

measurement point under the same machine by clicking  or  on toolbar. 

 

Plot Group (Waveforms) 
Click this command to view a group of waveform plots, based on dynamic samples of different measurement 

points under the same machine, moreover, those dynamic samples were collected at the same time. 

Display waveform plot group: Ensure Display module on local Display Terminal is started. Select the 

dynamic sample and then directly click  on toolbar (or select Plot Group/Waveforms command from Plots 

menu; or right click this sample and then select Plot Group/Waveforms from shortcut menu). 
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When viewing plot group of the selected dynamic samples, you can navigate to plot group of previous or next 

dynamic samples of different measurement points under the same machine by clicking  or  on toolbar. 

 

Plot Group (Spectrums) 
Click this command to view a group of spectrum plots, based on dynamic samples of different measurement 

points under the same machine, moreover, those dynamic samples were collected at the same time. 

Display spectrum plot group: Ensure Display module on local Display Terminal is started. Select the 

dynamic sample and then directly click  on toolbar (or select Plot Group/Spectrums command from Plots 

menu; or right click this sample and then select Plot Group/Spectrums from shortcut menu). 
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When viewing plot group of the selected dynamic samples, you can navigate to plot group of previous or next 

dynamic samples of different measurement points under the same machine by clicking  or  on toolbar. 

 

Plot Group (Shaft XY Vibration) 
Click this command to view a group of shaft XY vibration plots, based on dynamic samples of different 

measurement points under the same machine, moreover, those dynamic samples were collected at the same 

time. 

Display shaft XY vibration plot group: Ensure Display module on local Display Terminal is started. Select 

the dynamic sample and then directly click  on toolbar (or select Plot Group/Shaft XY Vibration command 

from Plots menu; or right click on this sample and then select Plot Group/Shaft XY Vibration from shortcut 

menu). 
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When viewing plot group of the selected dynamic samples, you can navigate to plot group of previous or next 

dynamic samples of different measurement points under the same machine by clicking  or  on toolbar. 

 

Plot Group (Waveforms (R)) 
Click this command to view a group of real-time waveform plots, based on real-time data from measurement 

points under the same machine. 

Display real-time waveform plot group: Ensure both DAQ and Display modules are started. From tree view, 

select a machine and then select Plot Group/Waveforms (R) command from Plots menu (or right click this 

machine and then select Plot Group/Waveforms (R) from shortcut menu). 
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Plot Group (Spectrums (R)) 
Click this command to view a group of real-time spectrum plots, based on real-time data from measurement 

points under the same machine. 

Display real-time spectrum plot group: Ensure both DAQ and Display modules are started. From tree view, 

select a machine and then select Plot Group/Spectrums (R) command from Plots menu (or right click this 

machine and then select Plot Group/Spectrums (R) from shortcut menu). 
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Plot Group (Shaft XY Vibration (R)) 
Click this command to view a group of real-time shaft XY vibration plots, based on real-time data from 

measurement points under the same machine. 

Display real-time shaft XY vibration plot group: Ensure both DAQ and Display modules are started. From 

tree view, select a machine and then select Plot Group/Shaft XY Vibration (R) from Plots menu (or right click 

this machine and then select Plot Group/Shaft XY Vibration (R) from shortcut menu). 
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Save User Plot 
This command is used to save user-defined window and the information about the window will be saved to the 

database. After finished the window setting, select Save User Plot command (or directly click the shortcut icon 

 on toolbar) from User menu and then “Save User Plot” window is launched. 

 
Name the plot and then click OK button. 

NOTES: 

1. Maximum 8 customized windows can be defined. If there are already 8 windows and you save another, 

the first window will be replaced by the ninth one (FIFO). 

2. When save a customized plot, the current status of the historical data you select to view will be recorded. 

It will be displayed behind the plot name. 
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Open User Plot 
This command is used to open a saved user-defined plot. Select Open User Plot command from User menu 

(or directly click shortcut icon  on toolbar) and then select the available plot from the saved plot list. 

 

When you click Open User Plot command, all saved plots will be displayed, and meanwhile, the status of the 

historical data for view when you saved the plot is also displayed behind the plot name. Note that you are only 

allowed to open plots marked the same status as current status of the historical data you select to view. For 

example, you saved a plot marked “Startup” status, when current status of the historical data for view is also 

“Startup”, you could view the plot. The plots marked other statuses can’t be opened. 
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PCM360DW System Maintenance 

4-20mA Calibration for DM200 
The 4-20mA calibration process is below: 

1. Run DM200-CFG software, and connect the software and DM200 device. Ensure they can normally 

communicate with each other. 

2. Connect the ammeter and DM200 device. To perform step 1 and step 2, please refer to DM200 System 

Wiring Diagram for Configuration (Consult DM200-CFG User Manual). 

3. Select Calibration command from Calibration menu. Before the calibration, make sure system 

configuration password has been activated; otherwise you should click Activate button from “4-20mA 

Calibration” field to activate the configuration password first. 

Step 4-step 5 covers the process to complete zero calibration. 

 

4. Refer to picture above. Select a channel and then click Zero Calibration button. 

5. Type the current value read from the ammeter into the related edit box and click Download button. 

 

Step 6-step 7 covers the process to complete full scale calibration. 

6. Click Full Scale Calibration button, and then read the current value from the ammeter and type it into the 
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related edit box. Finally, click Download button. 

 

7. Click Stop Calibration button to finish the channel 1 calibration. 

8. Repeat the steps above to calibrate channel 2. After two channels were calibrated, click Exit button. 

 

Calibration for DTM 

Zero Calibration 

The 4mA zero calibration process is below: 

1. Run DTM-CFG software, and connect the software and DTM device. Ensure they can normally 

communicate with each other. 

2. Connect the ammeter and DTM device. To perform step 1 and step 2, please refer to DTM System 

Wiring Diagram for Configuration (Consult DTM-CFG User Manual). 

3. Directly click Calibration button on main window or select 4mA Calibration command from Operation 

menu. Window below is launched. To start zero calibration, you should activate it by configuration 

password. 

 
4. Click Start Calibration button on the window. 
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5. Read the current value from the ammeter and type it to the edit box. 

 
6. Click Zero (4mA) Calibration button to download the current value to DTM device. 

 
7. Click Exit button to exit the calibration status. 

 

4-20mA Calibration For User 

The 4-20mA calibration process is below: 

1. Run DTM-CFG software, and connect the software and DTM device. Ensure they can normally 

communicate with each other. 

2. Connect the ammeter and DTM device. To perform step 1 and step 2, please refer to DTM System 

Wiring Diagram for Configuration (Consult DTM-CFG User Manual). 

Step 3-step 4 covers the process to complete Zero 4-20mA Calibration. 
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3. Enter DTM-CFG software advanced edition. Select 4-20mA Calibration For User command from 

Calibration menu. On “4-20mA Calibration” window, click Start calibration button in “Zero” field. 

 

4. Type the current value read from the ammeter into the related edit box and click Calibration button. 

 

Step 5-step 6 covers the process to complete Full scale 4-20mA Calibration. 

5. Click Start calibration button in “Full scale” field. 

6. Type the current value read from the ammeter into the related edit box and click Calibration button. 

 

7. Click Exit button to complete the calibration. 

 

Troubleshooting 

Display Module Fails to Acquire Real-time Data 

If Display Terminal can’t acquire the real-time data from other PCM360 DAQ Servers in the same PCM360 

system, please first check the following: 

 The network communication. Ensure the network is working properly. 
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 System configuration. Ensure system configuration is correct. 

If the two options above can be eliminated, then you should check the system UDP Port. Probably the current 

system UDP Port is being used by other application program. To change the system UDP Port, please refer to 

Troubleshooting/UDP Port Is Being Used. 

 

Fail to Log on the Computer by Windows Administrator Account 

To install MS SQL Server 2008 WorkGroup Edition, you should log on the computer by Windows 

Administrator account. If you can’t log on the computer by this account, please try the method mentioned 

below: 

1. Log on the computer by other account. 

2. Right click “My Computer” on the Desktop and select Manage from the shortcut menu. 

        

3. On “Computer Management” window (see picture above), select Computer Management 

(Local)->System Tools->Local Users and Groups->Users. 

4. From the right panel, double click “Administrator” item and the “Administrator Properties” window is 

launched. On General tab, deselect “Account is disabled” and click OK button. 

 
Finally log off the computer and select “Switch User” to re-log on it by Windows Administrator account. 
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Fail to Log on DBM Software 

When you log on the DBM software, following message box is launched: 

 

That indicates current database was damaged. 

Solution: Click Yes button to drop the database, and then click Attach button on “Database Manager” 

window. If succeed in attaching database, software will launch following message box. 

 
If software failed to attach the database, you should contact your local ProvibTech representative. 

 

Fail to Backup Database 

 

If the message box above is launched when software is backing up the database, please check: 

1. SQL Server is running normally. 

2. Disk space for saving backup record is available. Make sure the disk available space is at least three 

times the size of the backup record. 

If still cannot backup the database, please contact your local ProvibTech representative. 
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Fail to Restore Database 

 

If the message box above is launched when software is restoring the database, please check: 

1. SQL Server is running normally. 

2. The related backup record is produced by DBM software. 

3. The related disk available space is at least three times the size of the backup record. 

If still cannot restore the database, please contact your local ProvibTech representative. 

 

DB File Isn’t Compatible with PCM360 Software 

If the version of the current DB file is not supported by the PCM360 software, a message box will be launched 

to inform you when log on the software. 

Solution: Uninstall the DBM&Server software and re-install it; or replace the DB file under the “DB” folder of 

the destination path. 

 

Error in Connecting to Database 

If system failed to connect to the database, message box below will be launched. 

 
Please check the following: 

 The network status is not normal. 

Re-connect the network cable and restart PCM360 system. 

 The DAQ&COM software or Display software has connected to a wrong DB Server. 

Check it on software’s “Logging On” window. 

 The DB Server is powered off or the DB Server is hibernating. 
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You must keep the DB Server always on. Follow the instructions to set the computer power properties. Open 

“Control Panel” and double click “Power Options”. “Power Options Properties” window is launched. On Power 

Schemes tab, set “Power schemes” to “Always On”; set “Turn off hard disks” to “Never”; set “System standby” 

to “Never”. 

 

And then switch to Hibernate tab, de-select “Enable hibernation” check box. 

 

Finally, click OK button to apply all settings. 

 The Windows Firewall is on. 

You could directly turn off the Windows Firewall to solve the problem. And if you want to keep the Windows 

Firewall on, you should follow instructions below: 

1. Open “Control Panel” and click “Windows Firewall”. 

2. On Exception tab of “Windows Firewall” window, click Add Port button. 
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Name the port as “SQL Server” and type 1433 in “Port number” edit box. And then select TCP option. 

 You have changed the Windows account information for SQL Server service, and meanwhile the 

PCM360 system uses MS SQL Server 2008 WorkGroup Edition software. 

Take Windows XP operating system as an example and try the following: 

1. Open “Control Panel”; double click “Administrator Tools”; On “Administrator Tools” window, double 

click Services shortcut. 

 

2. On right panel of the “Services” window, find the following five services options: 

 SQL Server (MSSQLSERVER) 

 SQL Server Agent (MSSQLSERVER) 

 SQL Server Analysis Services (MSSQLSERVER) 

 SQL Server Integration Services 10.0 

 SQL Server Reporting Services (MSSQLSERVER) 

Set the five services: Take “SQL Server (MSSQLSERVER)” as an example. Double click this option and 

following window appears. 
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Switch to Log On tab; mark “This account” if the current setting is “Local System account”. Ensure the 

logon setting is set the same as the current Windows logon account information. 

 
Later, click OK button to apply all settings. Then consult the instruction above to set other four services. 

 

Tree View on Display Module Can’t Work Normally (Unpredictable Error 
Happens) 

Check the following options: 

 If Display software wasn’t installed on DB Server and meanwhile your Display Terminal runs on Windows 

2000 operating system or Windows XP operation system with version former than SP2, you should install 

MDAC, version 2.9.1 or later on Display Terminal. Please visit Microsoft Website to download the most 

recent version of MDAC. 

 If Display software wasn’t installed on DB Server and meanwhile your Display Terminal runs on Windows 

Vista operating system, please visit Microsoft Website to download the most recent version of Service 
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Pack package and then upgrade the current operating system. 

 

UDP Port Is Being Used 

If the system UDP port is being used by other application program when log on PCM360 software, following 

message box will be launched. 

 

Under this condition, please log on software first and stop the system, and then select UDP Port Setup 

command from Setup menu. 

 

Type an available UDP port and then click OK button. 

CAUTION: To apply the new UDP port, after re-set the system UDP port, you must exit PCM360 software 

(contains DAQ&COM, Display, Server, and Web Server) on all PCM360 Terminals, and then re-run them. 

 

“Error” Window Is Launched 

 
If the “Error” window shown like above is launched, please check the following: 

1. The Server software is running normally. 

2. The Softdog is indeed plugged on the DB Server. 
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Appendix 

Appendix I. Installing MS SQL Server 2000 Personal Edition 
MS SQL Server must be installed on DB Server. Follow the steps below to install MS SQL Server 2000 

Personal Edition. 

1. Put the SQL Server 2000 Personal Edition CD into the DVD-ROM. It should normally be automatically 

detected, or else select the drive and run the Setup.exe file. 

2. Select “SQL Server 2000 Components”. 

 

3. Select “Install Database Server”. 

 

4. The Setup will launch “Welcome” window. Click Next button. 

 

5. Select “Local Computer”. 
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6. Select “Create a new instance of SQL Server, or install Client Tools”. 

 

7. Enter your name and your company name. Click Next button to continue. 

8. The Setup will launch “Software License Agreement” window. Click Yes button. 

 

9. Select “Server and Client Tools”. And click Next button. 

 

10. Mark “Default” and click Next button. 
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11. Select “Typical” and click Next button. 

 

12. Select “Use the same account for each service. Auto start SQL Server Service”. And select “Use the Local 

System account” in Service Settings. Click Next button. 

 

13. Select “Mixed Mode (Windows Authentication and SQL Server Authentication)”, and mark “Blank 

Password (not recommended)”. Click Next button. 
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14. The Setup will launch “Start Copying Files” window. Click Next button. 

 

15. Restart the computer! 

16. Insert Standard Edition Service Pack 4 Installation CD into DVD-ROM and install it. Click Next button. 

 

Click Yes button. 

 

Click Next button. 
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Select “The SQL Server system administrator login information (SQL Server authentication)” and leave the 

“Enter sa password” field blank. And then click Next button. 

 

The Setup will launch the window below: Select “Ignore the security threat warning, leave the password blank” 

and then click OK button. 

 
Mark “Upgrade Microsoft Search and apply SQL Server 2000 SP4 (required)” and then click Continue button. 

 

The Setup will launch “Error reporting” window, and later click OK button. 
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Click Next button. 

 

Click Finish button. 

 

17. Restart your computer again! 

18. Select Windows Start->All Programs->Microsoft SQL Server->Service Manager. Make sure SQL 

Server and SQL Server Agent Services are started. 

 Select “SQL Server” from Services field and click Start/Continue button to start it. And mark 

“Auto-start service when OS starts”. 
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 Select “SQL Server Agent” from Services field and click Start/Continue button to start it. And mark 

“Auto-start service when OS starts”. 

 

Appendix II. Register Address for PT371 
 

Device Channel Property Channel No. Register Address 

Channel 0 30001 
Channel 1 30002 
Channel 2 30003 
Channel 3 30004 
Channel 4 30005 
Channel 5 30006 
Channel 6 30007 
Channel 7 30008 
Channel 8 30009 
Channel 9 30010 
Channel 10 30011 
Channel 11 30012 
Channel 12 30013 
Channel 13 30014 
Channel 14 30015 

PT371 Input 

Channel 15 30016 



PCM360DW Condition Management System 
 
 
 

ProvibTech      Phone: +1-713-830-7601 Fax: +1-281-754-4972 sales@provibtech.com, www.provibtech.com 
138 

Appendix III. Register Address for PT372 
 

Device Channel Property Channel No. Register Address 

Channel 0 40001 
Channel 1 40002 
Channel 2 40003 

4-20mA Output 

Channel 3 40004 
Channel 0 1 
Channel 1 2 
Channel 2 3 
Channel 3 4 
Channel 4 5 
Channel 5 6 
Channel 6 7 

PT372 

Relay Output 

Channel 7 8 

 

Appendix IV. Register Address for PT373 
 

Device Channel Property Channel No. Register Address 

Channel 0 1 
Channel 1 2 
Channel 2 3 
Channel 3 4 
Channel 4 5 
Channel 5 6 
Channel 6 7 
Channel 7 8 
Channel 8 9 
Channel 9 10 
Channel 10 11 
Channel 11 12 
Channel 12 13 
Channel 13 14 
Channel 14 15 

PT373 Relay Output 

Channel 15 16 
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Appendix V. Register Address for DTM, PT580, and DM200 
 

Device Channel Property Channel No. Register Address 

DTM Input Channel 0 30501 

PT580 Input Channel 0 30501 

Channel 0 30501 
DM200 Input 

Channel 1 30503 

 

Appendix VI. Glossary 
* Absolute Vibration  

Vibration of an object as measured relative to an inertial (fixed) reference frame. Acceleration transducers and velocity 

transducers measure absolute vibration typically of machine housings or structures; thus they are referred to as seismic 

transducers. 

* Acceleration  

The time rate of change of velocity. For harmonic motion, this is often expressed as g or a.  Typical units for acceleration 

are feet per second per second (ft/s2), meters per second per second (m/s2), or more commonly "g" (where g = 

acceleration of earth's gravity = 386.1 in/s2 = 32.17 ft/s2 = 9.81 m/s2).  Acceleration measurements are generally made with 

piezoelectric accelerometers and are typically used to evaluate high frequency machine casing or bearing housing 

response characteristics. 

* Acceleration transducer 

An Acceleration transducer is a seismic transducer which converts the acceleration characteristic of vibration into a 

proportional electric signal. 

* Aliasing 

False frequency components caused by sampling a dynamic signal at a sampling frequency too low. The sampling 

frequency must be at least twice the highest frequency of interest or the highest frequency component in the signal. This 

effect can be eliminated by adjusting the sampling frequency, or using a low-pass filter on the signal prior to sampling 

(anti-aliasing.)  The primary disadvantage of anti-aliasing (as is the case with virtually any type of filtering) is that phase and 

amplitude errors are incurred. 

* Alignment 

The positioning of machine components; bearings, rotors, casing, foundation, piping, etc., with respect to each other for 

efficient transfer of power. Various alignment requirements utilize different techniques of cold and hot machine 

measurement including optical, mechanical (dial indicators), electronic (proximity probes), and laser. 

* Amplitude 

The magnitude of periodic dynamic motion (vibration). Amplitude is typically expressed in terms of signal level, e.g., 

millivolts or milliamps, or the engineering units of the measured variable, e.g., mils, micrometers (for displacement), inches 
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per second (for velocity), etc. The amplitude of a signal can be measured in terms of peak-to-peak, zero-to-peak, root mean 

square, or average. 

* Asynchronous or Non-synchronous 

Vibration frequency component which is different than shaft rotative speed. Sometimes used to mean any vibration 

frequency which is not an integer multiple or fraction of rotative frequency.  

* Attitude Angle 

The included angle between the direction of the vector sum of all the unidirectional, steady state, radial loads (Preloads) on 

a rotor and a line connecting the bearing and shaft centers. Sometimes confused with Rotor Position Angle, since the 

preload historically and incorrectly, was considered to be primarily gravity on horizontal machines. 

* Average 

An amplitude detection technique used for sine wave vibration signals; the half cycle average is 0.637 x zero-to-peak 

amplitude. Average amplitude detection is not used by ProvibTech because machinery vibration signals are most often 

non-sinusoidal in form and the peak-to-peak, or peak amplitude, cannot be correctly computed. 

* Average Shaft Position 

The static or average position of the shaft relative to a stationary component on the machine to which the probe is mounted.  

The most common application is rotor axial thrust position relative to the thrust bearing. Another important application is 

shaft average radial position in the bearing. These measurements are made using the dc (position) component of the 

proximity probe signal. Two proximity probes mounted in an XY configuration are required for the two-dimensional radial 

position measurement. 

* Axial 

In the same direction as the shaft centerline. 

* Axial Position 

The average position, or change in position, of a rotor in the axial direction with respect to some fixed reference.  Typically, 

the reference is the thrust bearing support structure or other casing member to which the probe is mounted.  The probe may 

observe the thrust collar directly or some other integral, axial shaft surface, as long as it is within about 12 inches of the 

thrust bearing.  Also called thrust position.  

* Balancing 

Adjusting the radical mass distribution of a rotor so that the mass centerline (principal inertia axis) approaches or coincides 

with the rotor rotational axis.  This reduces the 1X lateral vibration of the rotor and the forces on the bearings due to 

imbalance inertia forces. 

* Bandwidth 

The span between the corner frequencies of a band-pass filter. Normally expressed in terms of frequency for constant 

bandwidth filters and as a percent of the center frequency for constant percentage (constant Q) filters. 

* Bode Plot 

A pair of graphs in Cartesian format displaying the 1X vibration vector (phase and amplitude) response as a function of 

shaft rotative speed.  The Y axis of the top graph represents 1X phase lag angle, while the Y axis of the bottom graph 

represents 1X amplitude.  The common X axis represents shaft rotative speed.  Sometimes called as an imbalance 

response plot.  Also used for 2X, 3X, etc., vibration response vectors. 

* Bow  



PCM360DW Condition Management System 
 
 
 

ProvibTech      Phone: +1-713-830-7601 Fax: +1-281-754-4972 sales@provibtech.com, www.provibtech.com 
141 

A shaft condition such that the geometric shaft centerline is not straight.  Usually the centerline is bent in a single plane due 

to gravity sag, thermal warpage, etc.; however, the bow may be three dimensional (corkscrew).  Shaft bow can be detected 

by measuring the shaft relative displacement with a proximity probe(s) at rotor slow roll speed. 

* Calibration Weight  

Used in rotor balancing procedures, a weight of known magnitude which is placed on the rotor at a known location, under 

known operating conditions, in order to measure the resulting change in machine 1X vibration response. In effect, such a 

procedure "calibrates" the rotor system (a known input is applied, and the resultant output is measured) for its susceptibility 

to imbalance.  Sometimes called "trial weight" 

* Cartesian Format  

A rectangular graphical format consisting of a vertical (Y) axis and a horizontal (X) axis. This format is used to graph the 

results of one variable as a function of another; e.g., vibration amplitude versus time (trend), amplitude versus frequency 

(spectrum) and nX amplitude versus shaft rotative speed (Bode). 

* Cascade Plot  

A graph in Cartesian format displaying amplitude versus frequency spectra at series shaft rotative speeds.  Shaft rotative 

speed and amplitude are usually presented on two separate vertical axes.  Frequency is measured on the horizontal (X) 

axis. This data format is used to evaluate the change in vibration frequency characteristics during machine transient 

conditions.  

* Casing Expansion  

A measurement of the axial position of the machine casing relative to a fixed reference, usually the foundation. The 

measurement is typically made with an LVDT installed on the foundation at the opposite end of the machine from the point 

where the casing is attached to the foundation. Changes in casing axial position are the result of thermal expansion and 

contraction of the casing during startup and shutdown. The measurement is usually incorporated as part of a TSI system. 

* Center Frequency  

For band-pass filters the arithmetic center of a constant bandwidth filter or the geometric center (midpoint on a logarithmic 

scale) of a constant percentage filter. 

* Channel 

A transducer and the instrumentation hardware to display its output signal. 

* Critical Machinery  

That group of rotating equipment which is absolutely necessary to a major part of the plant process. When critical 

machinery is not operating, the part of the process is not operating. Machines in this category are usually without spare and 

are typically monitored continuously. 

* Critical Speed(s)  

In general, any shaft rotative speed which is associated with high (dangerous level) vibration amplitude.  Often, critical 

speed is used to describe a shaft rotative speed equal to a rotor system natural frequency.  This is more correctly called a 

balance resonance speed. 

* Cycle  

One complete sequence of values of a periodic quantity. 

* Decibels  

A numerical expression of the ratio of the power or voltage levels of electrical signals. dB = 10 log P1/P2 = 20 log V1/V2. 
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* Difference Analysis  

A method for evaluating the change in a measurement variable. Two sets of data are collected at different points in time, or 

under different conditions, and are subtracted from each other. 

* Differential Expansion  

The measurement of the axial position of the rotor with respect to the machine casing at some distance from the thrust 

bearing. Changes in axial rotor position relative to the casing affect axial clearances and are usually the result of thermal 

expansion during startup and shutdown. The measurement is typically made with a proximity probe transducer mounted to 

the machine casing and observing an axial surface (e.g., collar) of the rotor. The measurement is usually incorporated as 

part of a TSI system. 

* Differential Phase  

A technique which measures the phase difference between vibration signals of a chosen single frequency at different 

longitudinal locations on a rotor system. It is used for locating the source of instability. The vibration signal whose phase 

leads all others usually indicates the transducer location closest to the source of the instability. 

* Direct Data 

Data or a signal, which represents the original transducer signal.  Sometimes called unfiltered, raw, all pass, or overall data 

or signal. 

* Displacement  

The change in distance or position of an object relative to a reference. Machinery vibration displacement is typically a 

peak-to-peak measurement of the observed vibrational motion, and is usually expressed in units of mils or micrometers.  

Proximity probes measure displacement directly. Signal integration is required to convert a velocity signal to displacement. 

* Dual Probe  

A transducer set consisting of a proximity probe and velocity transducer installed radially at the same point (usually in a 

common junction box on the machine bearing housing). Four separate measurements are provided by this transducer 

system. The proximity probe measures (1) shaft relative radial position within the bearing clearance, and (2) shaft dynamic 

motion relative to the bearing. The velocity transducer measures (3) machine casing absolute vibration.  When the velocity 

signal is integrated to displacement and added to the shaft relative signal, the summation represents (4) shaft absolute 

motion. 

* Dual Voting  

A logical AND relationship between two independent monitor inputs; they must agree before any action is taken. For 

example, two transducer input signals must both exceed an amplitude set point (usually the Danger set point only) before 

an actual alarm condition is indicated by the monitor. If only one transducer input exceeds the set point, then no alarm is 

initiated in the monitor. 

* Dynamic Data  

Data (steady state and/or transient) which contain that part of the transducer signal representing the dynamic (e.g., 

vibration) characteristics of the measured variable.  Typical dynamic data presentations include shaft XY vibration, 

waveform, spectrum, Cascade, and Waterfall. 

* Error  

The difference between the indicated value and the true value of the measured variable. It is often expressed as relative 

error, i.e., as a percent of the output reading of the transducer. 
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* Essential Machinery  

That group of rotating equipment which is critical to part of the plant process. When essential machinery is not operating, 

the overall plant is not operating at full capacity. Machines in this category can be with or without spare and are typically 

monitored continuously. 

* Frequency 

The repetition rate of a periodic vibration per unit of time. Vibration frequency is typically expressed in units of cycles per 

second (Hertz) or cycles per minute (to more easily relate to shaft rotative speed frequency).  In fact, since many common 

machine malfunctions produce vibration which has a fixed relationship to shaft rotative speed, vibration frequency is often 

expressed as a function of shaft rotative speed. 1X is a vibration with a frequency equal to shaft rpm, 2X vibration is twice 

shaft rpm, 0.5X is a frequency equal to one-half shaft rpm, etc. 

* Frequency Component  

The amplitude, frequency and phase characteristics of a component of a dynamic signal. 

* Frequency Response  

The measured amplitude and phase response characteristics of a mechanical or electronic system with respect to 

frequency. 

* g 

The value of acceleration yielded by the force of earth's gravity, which varies somewhat with latitude and elevation. By 

international agreement, 9.8 m/s2 = 386 in/s2 = 32.17 ft/s2 has been chosen as the standard acceleration due to gravity. 

* Harmonics  

A series of vibration signal components whose frequencies are integer multiples of the fundamental, or lowest frequency, 

vibration component. 

* Harmonic Vibration  

Sinusoidal vibration with a single frequency component. 

* Hertz  

(Hz) Unit of frequency measurement in cycles per second. 

* High Frequency  

For purposes of studying rolling element bearings, a frequency range, typically above 5 kHz, used to measure the very high 

vibration frequencies associated with microscopic faults in bearing components. 

While this technique may provide the earliest warning of impending bearing failure for some types of bearing faults, there 

are several other machine malfunctions which can produce vibrations in this range (e.g., cavitation, rubs, etc.) In addition, 

the high frequency measurement technique sometimes provides warnings too early, long before any maintenance (bearing 

replacement) needs to be considered. 

* Hysteresis  

The difference in levels (dead band) between the trigger threshold and the reset designed to reduce false triggering. 

* Inertial Referenced  

Motion that is referenced to a mass whose inertia keeps it stationary, yielding absolute motion.  Also describes a transducer 

with an internal inertial reference mass. 

* Phase Reference Pulse  

That change in the output signal of the phase reference transducer caused by the phase reference event. 
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* Micro-inch  

 A unit of length or displacement equal to 10^-6 inches or 10^-3 mils. 

* Micro-metre  

A unit of length or displacement equal to 10^-6 meters.  One micro-meter equals 0.0394 mil. Also called micron (obsolete). 

* Mil  

A unit of length or displacement equal to 0.001 inch.  One mil equals 25.4 micrometers. 

* Mode Shape  

The deflected shape of a rotor at a specific rotative speed caused by an applied specific forcing function such as imbalance. 

Note, this is a three dimensional presentation of rotor lateral deflection in vibration mode along the shaft axis. 

* Natural Frequency  

The frequency of free vibration of a system. The frequency at which a lightly damped system will oscillate upon momentary 

displacement from its steady position by a transient force. The natural frequencies of a multiple degree of freedom system 

are the frequencies of the normal modes of vibration.  

* Noise  

Any component of a transducer signal which does not represent the variable intended to be measured. 

* 1X  

In a complex vibration signal, notation for the signal component that occurs at the rotative speed frequency. Also called 

synchronous. 

* 1/2X, 1/3X, 2/5X, 4/9X, ETC.   

In a complex vibration signal, notations for signal components having frequencies equal to fractions of rotative speed. Also 

called sub-harmonic and sub-synchronous. 

* Shaft XY Vibration 

The dynamic, two dimensional path of the centerline motion of a machine component, which is observed by XY 

transducers, in the plane of those transducers. When the transducers are XY shaft proximity probes, it is the shaft 

centerline lateral vibration, called precession. Observed with an oscilloscope in the X versus Y mode. Sometimes called 

orbital motion. 

* Peak-to-Peak Value  

The difference between positive and negative extreme values of an electronic signal or dynamic motion.  See Amplitude. 

* Period  

The time required for a complete oscillation or for a single cycle of events. The reciprocal of frequency. 

* Periodic Vibration  

Oscillatory motion whose amplitude pattern repeats in time. 

* Phase Lag Angle  

The timing relationship, in degrees, between two vibration signals, or a phase reference pulse and a vibration signal; also, 

the phase difference between two signals such as the input force signal and output response signal. The "lag" corresponds 

to "minus" in mathematical formulations. 

* Polarity  

In relation to transducers, the direction of output signal change (positive or negative) caused by motion toward or away from 

the transducer in its sensitive axis. Convention is that motion toward the transducer will produce a positive signal change. 
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* Polar Format  

A graphical format consisting of a center reference point surrounded by concentric circles. Vector information is graphed on 

this format by plotting magnitude (vibration amplitude) as the length of a radial line, and phase (vibration phase lag angle) 

as the clock position of the line. 

* Polar Plot  

Polar format presentation of the locus of the 1X (or 2X) shaft vibration vector from a single channel as a function of shaft 

rotative speed.  The Polar Plot is generated by in-phase and quadrature signals, usually during machine startup or coast 

down (transient operation). 

* Probe Gap  

The physical distance between the surface of a proximity probe tip and the observed surface. The distance can be 

expressed in terms of displacement mils, micrometers, or in terms of voltage (millivolts). Standard polarity convention 

dictates that a decreasing gap results in an increasing (less negative) output signal. 

* Probe  

Specifically, a proximity probe transducer, although sometimes used to describe any transducer. 

* Probe Orientation  

The angular location of a probe with respect to a polar coordinate system when viewed from the driver end of the machine. 

Typically, zero degrees are at top dead center (vertical) or at the horizontal right (3 o'clock) position on the coordinate 

system. 

* Proximity Probe  

A non-contacting device which measures the displacement motion and position of an observed surface relative to the probe 

mounting location. Typically, proximity probes used for rotating machinery measurements operate on the eddy current 

principle and measure shaft displacement motion and position relative to the machine bearing(s) or housing. 

* Radial  

A direction on a machine which is perpendicular to the shaft centerline in the XY plane; usually refers to direction of shaft 

lateral or casing motion or measurement. 

* Radial Vibration  

Shaft dynamic motion or casing vibration which is measured in a direction perpendicular to the shaft axis. 

* Relative Vibration  

Vibration measured relative to a chosen reference.  Proximity probes measure shaft dynamic motion and position relative 

to the probe mounting, usually the bearing or bearing housing. 

* Relative Transducer  

A proximity probe observing shaft motion relative to the probe mounting, usually the bearing or bearing housing. 

* Repeatability 

The ability of a transducer or readout instrument to repeat measurements, under the same conditions, within narrow limits.  

Precision is the measure of repeatability. 

* Resolution  

The smallest change in applied stimulus that will produce a detectable change in the instrument output. 

* Resonance  

The condition in which a forcing frequency coincides with a natural frequency of the system. A resonance typically is 
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identified by an amplitude peak, accompanied by a maximum rate of change of phase lag angle. 

* Root Mean Square (RMS)  

Square root of the arithmetic average of a set of squared instantaneous values.  Used as a measure of amplitude; rms 

equals 0.707 x peak (sine wave only). (0.707 = 1/squareroot (2)). 

* RTD  

An acronym for Resistance Temperature Detector; a sensor which measures temperature and change in temperature as a 

function of resistance. 

* RUB  

Machine malfunction consisting of contact between the rotating and stationary parts of a machine involving friction, 

impacting, and changes in system stiffness. 

* Seismic Transducer  

Any vibration transducer which measures the absolute vibration of an object. Acceleration transducer and velocity 

transducers measure absolute vibration, typically of machine housing or structures, and thus are both referred to as 

seismic, or inertial, transducers. 

* Sensitivity  

The ratio of the change in the output to a change in the input. A typical sensitivity for a proximity probe transducer is 200 

millivolts per mil (7.84 volts per millimeter). 

* Shaft Centerline Plot  

Transient or trend plot of the shaft average radial centerline position within the bearing clearance, presented in Cartesian 

format. 

* Shaft Rotative Speed  

The frequency at which a shaft is rotating at a given moment, usually expressed in units of revolutions per minute (rpm); 

may also be expressed in radians per second (mostly for laboratory work).  100 rpm equals approximately 10 radians per 

second; (100 rpm = 100 PI/30 radians per second). 

* Slow Roll Speed  

Low rotative speed at which dynamic motion effects from such forces as imbalance are negligible. The speed at which shaft 

bow can be measured. 

* Spectrum  

Commonly a presentation of the amplitudes of a signal's components as a function of its frequency. 

* Spectrum Plot  

An XY plot in which the X axis represents vibration frequency and the Y axis represents vibration amplitude. 

* Static Data  

Data which describes the quantitative characteristics of the measured parameter. Static data can also include quantitative 

values describing the conditions under which the parameter was measured.  For predictive maintenance purposes, static 

data is typically presented in various forms of trend plot. 

* Steady State Data  

Data (static and/or dynamic) acquired from a machine, at constant shaft rotative speed. 

* Steady State Dynamic Data 

Dynamic data acquired under steady state machine conditions.  Typical data presentations include shaft XY vibration, 
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waveform and spectrum.  This data can be instantaneously trended. 

* Steady State Static Data  

Static data acquired under steady state machine conditions.  Example: trend plot. 

* Sub-harmonic  

Sinusoidal component of a vibration signal that is a sub-multiple (integer fraction) of a fundamental frequency. 

* Sub-synchronous  

Component of a vibration signal which has a frequency less than shaft rotative speed. 

* Super-harmonic  

Sinusoidal component of a vibration signal that is an integer multiple of a fundamental frequency. 

* Super-synchronous  

Component of a vibration signal which has a frequency greater than shaft rotative speed. 

* Synchronous  

The component of a vibration signal that has a frequency equal to the shaft rotative frequency (1X). 

* Thermocouple  

A temperature sensing device comprised of two dissimilar metal wires which, when thermally affected (heated or cooled), 

produce a proportional change in electrical potential at the point where they join. 

* Threshold  

The level at which a trigger or other function is initiated. 

* Transducer 

A device for translating the magnitude of one quantity into another quantity. The second quantity often has units of measure 

different from the first and serves as the source of a useful signal.  Vibration transducers convert mechanical motion into a 

proportional electronic signal (typically a voltage-proportional signal). 

* Transient Data  

Data acquired under transient machine conditions (startup and coast-down). 

* Trend Data  

The periodic recording/storage of static and/or dynamic data for the purpose of observing changes as a function of time.  

Trend data is the most fundamental level of information in any predictive maintenance program. 

* Trend Interval  

The time period between consecutive data points on a Trend Plot. 

*Trend Plot  

A presentation in Cartesian format or polar format of a plot with the measured variable versus time. 

* Trigger  

Any event which can be used as a timing reference. A trigger for an oscilloscope will initiate the sweep of the beam across 

the face of the CRT.  A trigger signal for a digital vector filter is a phase reference pulse which serves to align the center 

frequency of the band-pass filter to shaft rotative speed. It provides a reference from which to measure shaft rotative speed, 

1X amplitude and phase lag angle. 

* TSI  

Acronym for Turbine Supervisory Instrumentation. A TSI system is a continuous monitoring system generally used on turbo 

generator sets.  It can include such measurement parameters as shaft radial vibration, shaft absolute vibration, axial 



PCM360DW Condition Management System 
 
 
 

ProvibTech      Phone: +1-713-830-7601 Fax: +1-281-754-4972 sales@provibtech.com, www.provibtech.com 
148 

position, differential expansion, case expansion, valve position, eccentricity peak-to-peak, zero speed, and shaft rotative 

speed.  The system may also include a vector filter which measures vibration phase lag angle for each vibration frequency. 

The TSI system consists of measurement transducers, monitors, interconnecting wiring and usually strip chart recorders or 

a microprocessor-based monitoring/data acquisition system. 

 * 2X, 3X, ETC.   

In a complex vibration signal, notation for signal components having frequencies equal to exact multiples of shaft rotative 

speed. Also called harmonic, super-harmonic, and super-synchronous. 

* Unbalance  

Unequal radial mass distribution on a rotor system; a shaft condition where the mass centerline (principal inertial axis) does 

not coincide with the geometric centerline. Also, the effective mass that causes rotor vibration. 

* Vector  

A quantity which has both magnitude and direction. For a vibration vector, magnitude is expressed as amplitude 

(displacement, velocity, or acceleration) and direction as phase lag angle (degrees).  For example, the 1X vibration vector 

measured at shaft operating speed, e.g., for balancing purposes, will be described as magnitude (mils or micrometers) 

acting in a particular direction (degrees).  The vector data presentation which is easiest to interpret is the polar format.  

* Velocity  

The time rate of change of displacement.  Typical units for velocity are inches/second or millimeters/second, zero-to-peak.  

Velocity measurements are used to evaluate machine housing and other structural response characteristics. Electronic 

integration of a velocity signal yields displacement. 

* Vibration 

The oscillatory (back and forth) motion of a physical object. 

* Waterfall Plot  

Similar to Cascade plot, except that one vertical axis is usually time instead of shaft rotative speed (rpm). 

* Waveform  

A presentation or display of the instantaneous amplitude of a signal as a function of time. 

 * XY  

Orthogonal (perpendicular) axes in a Cartesian coordinate system.  Usually used as a reference for orthogonal (mutually 

perpendicular) radial vibration transducers. Y represents the vertical axis and X represents the horizontal axis. 

* Zero-to-Peak Value  

One-half of the peak-to-peak value.  
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4. Mark's Mechanical Engineering Handbook.  McGraw-Hill Book Company, New York, New York. 

5. Mechanical Equipment Standards for Refinery Service. American Petroleum Institute, Washington, D.C. 


